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RESUMEN

La investigacion fue realizada en la cuenca del rio Tumbes en una superficie de 1
663,28 Km2 en altitudes entre 0 a 1589 m.s.n.m. y médulo pluviométrico anual que
va desde 278,743 a 887,244 mm. El objetivo del estudio fue estimar la tasa de
erosion hidrica en la cuenca del rio Tumbes, aplicando la metodologia RUSLE con
técnicas de teledeteccién; RUSLE es un método que integra cinco factores mediante
el uso de herramientas SIG, el factor (R) se determin6é a partir de precipitaciones
acumuladas mensuales, el factor (K) se estimd con clases texturales y materia organica
obtenidas de SoilGrids, el factor (LS) se obtuvo a través de un modelo de elevacién
digital (DEM) obtenido del MINAM, el factor (C) se estim6 a partir de imagenes
satelitales landsat 7 y 8. Los resultados obtenidos respecto a la erosion hidrica
potencial (sin considerar la cobertura vegetal, ni practicas de conservacion), indican
gue la mayor parte de la cuenca (31,92%) experimenta pérdidas mayores a 200
Tn/Ha/Afio considerada critica, mientras que un menor porcentaje (8,11%) tiene
pérdidas inferiores a 5 Tn/Ha/Afo con una clasificacion baja. En comparacion, la
erosion actual muestra que la mayoria de la cuenca (58,16%) presenta pérdidas
menores a 5 Tn/Ha/Afio y en menor porcentaje (0.25%) erosion mayor a 200
Tn/Ha/Afo, todo esto bajo la clasificacién de la FAO. En cuanto a la tasa de erosion se
obtuvo una tasa de erosién potencial de 167,18 Tn/Ha/Afo y una tasa de erosion actual

de 5,06 Tn/Ha/Afo generando mapas de erosion de suelo (periodo 2000 i 2022).

Palabras clave: Erosion hidrica, suelo, RUSLE, teledeteccion, sistemas de

informacion geografica (SIG).
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ABSTRACT

The research was conducted in the Tumbes river basin over an area of 1663,28
kmz2, ranging in altitudes from O to 1589 meters above sea level, with an annual
rainfall ranging from 278,743 to 887,244 mm. The aim of the study was to estimate
the water erosion rate in the Tumbes river basin, using the RUSLE methodology
with remote sensing techniques. RUSLE is a method that integrates five factors
using GIS tools. Factor (R) was determined based on monthly accumulated
precipitation, factor (K) was estimated using textural classes and organic matter
obtained from SoilGrids, factor (LS) was obtained through a digital elevation model
(DEM) obtained from MINAM, and factor (C) was estimated from Landsat 7 and 8
satellite images. The results regarding potential water erosion (without considering
vegetation cover or conservation practices) indicate that the majority of the basin
(31,92%) experiences losses greater than 200 Tn/Ha/Year, considered critical,
while a smaller percentage (8,11%) has losses lower than 5 Tn/Ha/Year with a low
classification. In comparison, current erosion shows that the majority of the basin
(58,16%) experiences losses lower than 5 Tn/Ha/Year, and a smaller percentage
(0,25%) has erosion greater than 200 Tn/Ha/Year, all under the FAO classification.
Regarding the erosion rate, a potential erosion rate of 167,18 Tn/Ha/Year and a
current erosion rate of 5.06 Tn/Ha/Year were obtained, generating soil erosion maps
(period 2000-2022).

Keywords: Water erosion, soil, RUSLE, Remote sensing, geographic information

systems (SIG).
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CAPITULO |

1. INTRODUCCION

El crecimiento econdémico y social de un pais esta estrechamente relacionado con
la disponibilidad de sus riquezas naturales, particularmente las tierras, llevando a
cabo un uso sostenible e integrado a través del tiempo (Cisneros et al., 2012), ya
gue el suelo provee de los nutrientes necesarios para la produccién de alimentos,
asegurando la subsistencia de los seres vivos en el medio donde interactdan. En
este contexto en la degradacion de los suelos, la erosién es un problema a escala
mundial porque disminuye significativamente la capacidad de produccién, con

danos irreversibles.

Los problemas ambientales, tales como la erosion hidrica de los suelos ha sido un
tema que ha permanecido ignoto o considerado secundario, puesto que se ha
subestimado la importancia de un entorno equilibrado, no obstante, el panorama
gue se presenta hacia el deterioro ambiental es una conminacion grave al
desenvolvimiento del presente y futuro (SEMARNAT, 2009), en el Peru este
problema afecta abundante superficie nacional en diferentes grados de rigidez, en
tal sentido, de acuerdo con el estudio realizado por INRENA en el afio 1996,
determind que en el territorio nacional se produce el 41,40% de erosion hidrica nula
o ligera, el 27,40% erosion hidrica moderaday el 24,40% erosion alta, sumando un

total de 8 millones de hectareas afectadas.

La cuenca del rio Tumbes no es indiferente a este preocupante hecho, pues es
evidente la reduccion de la cobertura vegetal por acciones antropicas, sumandole
las pendientes pronunciadas en la cabecera y fuertes precipitaciones que se dan
por la presencia de la corriente del nifio, ante toda esta situacién es necesario
adoptar una metodologia con la que se pueda estimar la tasa de pérdida del suelo
por erosion hidrica y con ello reconocer las areas con principal riesgo y proponer
medidas de conservacion, por ello se hara uso de la metodologia RUSLE aplicando
técnicas de teledeteccién utilizando el entorno Gis, para determinar cada uno de

los factores que intervienen en esta ecuacién universal.

23



CAPITULO II

2. ESTADO DEL ARTE
2.1. ANTECEDENTES

Domari o (2016) en su tesis de grado AEval ua
distribucién espacial y el efecto de la cobertura vegetal en el proceso erosivo, en la
cuenca hidrogrs8fica del R2 o, ddndenell gbietivo Super
principal de esta investigacion fue evaluar el riesgo de erosion hidrica, distribucion
espacial, asi como el impacto de la cobertura vegetal en el proceso de erosion, en
la cuenca del rio Tunuyan Superior (Mendoza), con el fin de sugerir pautas de
implementacion. Para ello aplico la metodologia RUSLE (Revised Universal

Equation of Land Loss).

El autor concluye que el 4,6% del area de la cuenca estudiada pertenece al estrato
de muy alta erosion y el 28,2% al estrato alto. La mayoria de ellos (55,5%)
presentaron erosion moderada, todos estos resultados en base a la clasificacion
dada por la FAO.

Mendes et al. (2018), en su artzculo cient?
cul t i vpkartteddb como objetivo estimar las pérdidas de suelo asociada con el
limite de tolerancia a la pérdida de suelo en Oxisoles (Latossolos Vermelhos
Distroficos) bajo cultivo de café. Este estudio fue realizado en marzo de 2015 a
enero de 2017 en la Subcuenca hidrografica Corrego da Laje. utilizé la metodologia
RUSLE desarrollada a través de técnicas de geoprocesamiento, imagenes de
teledeteccion y datos de literatura. Los resultados obtenidos muestran pérdidas
potenciales de suelo de 0,01 a 18,77 Mg ha™* afio, con un promedio de 1,52 Mg
ha! afio. La tolerancia a la disminucién de suelo vari6 de 5,19 a 5,90 Mg ha* afio-
1, con 7,35 % del area con mayores pérdidas. Las areas con pendientes mas
pronunciadas y sin practicas sostenibles tienen pérdidas de suelo por encima del
nivel de tolerancia y, por lo tanto, son una prioridad para la adopcién de medidas
para mitigar los efectos erosivos. En cuanto al uso de la ecuacién RUSLE, logré
optimizar costos y tiempo al momento de evaluar los factores involucrados en la

disminucién de la pérdida de suelo.
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Dioses y P®rez (2018) Estnmcios de la erosidonshidridee

medi ante | a aplicaci-n de | a metodol o

Donde su proposito principal fue estimar la tasa de erosion hidrica de la cuenca
hidrografica del rio Piura aplicando la metodologia RUSLE. En un periodo de
estudio de 35 afios (1981-2016), utilizando la percepcion remota como principal
herramienta. Evalué los factores de la siguiente manera: el factor Erosividad R con
data de PISCO Senamhi a través de una interpolacion mensual; el factor
erodabilidad K con data de la plataforma SOILGRID en base a textura del suelo,
estructura y capacidad de drenaje; el factor longitud y pendiente LS haciendo uso
de un digital elevation model (DEM, por sus siglas en inglés); el factor Cobertura
Vegetal C basado en la data del Ministerio del ambiente. Concluyendo que el mayor
grado de erosion se presenta en el rango de normal y ligero con valores de 0,5 a5
Tn/ha-afio en las zonas bajas, por otro lado, en la cabecera de la cuenca el grado
de erosion esta en el rango de medio a muy alto en el rango de 5 a 50 Tn/ha-afio.
Dentro de los afios de estudio resaltan con la maxima erosion hidrica los afios 1983,
1998 y 2001 a consecuencia de las impetuosas precipitaciones provocadas por el

fendmeno del nifo.

FIl ores (2015) en su tesis de grado i
aplicando un SIG en la cuenca Shambillo, distrito de Padre Ab ad o , u
met odol og? a de | a AEcuaci -n Uni vers
(USLE/RUSLE), haciendo uso de las SIG y técnicas de teledeteccion. Respecto a
los factores involucrados en la ecuacién, el factor i R0 s e gener -

del indice de Fuirier modificado (IMF) y la ecuacion de Foster; referente al factor
Erodabi |l i da dapiicEknao |lafémutalde Wisctoneier (1978), tomando en

cuenta la textura del suelo, materia organica, estructura y permeabilidad a través

gr
g?a

al

medi

ad
R L

an

de muestras de suelos; el factor topogr 8fic

Renard et al (1997) ; el factor de cobertur

clasificacion supervisada de cada uso y cobertura de suelo; respecto al f ac
se asumio el valor de 1, debido a que no se desarrollan practicas de conservacion
de suelos en el area de estudio, obteniendo entre sus resultados mas resaltantes
una erosion potencial media (no considera la cobertura vegetal) de 71,46 tn/ha/afio,

en cuanto a la erosion real sobresalié la media de 26,87 tn/ha/afio. En términos mas
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especificos el 98,8% del area presenta una erosion baja y el 0,2% evidencia una

erosion no significativa que sobrepasa los limites de clasificacion aceptables.

Sabino ( 2016) en su tesis dei tgmpara de efo#Aom 8d
suelos por regiones hidrolégicas en el Perd (198171 2014) 0 ti ene

principal evaluar la variabilidad espacio i temporal de la pérdida por erosion de
suelos a nivel de Regiones Hidrolégicas en el Perl aplicando el modelo RUSLE.
Los factores involucrados en esta metodologia fueron tratados y manejados con
técnicas de percepcion remota. Estos factores fueron evaluados de la siguiente
manera: el factor erosividad (R) fue obtenido del producto PISCO SENAMHI a
través de imagenes satelitales interpolando la precipitacion mensualmente, el mapa
de erodabilidad (K) se proceso a partir de las caracteristicas fisicas del suelo con
apoyo de imagenes satelitales, el mapa de cubierta vegetal (C) se baso en la data
de vegetacion del pais, el factor topografico (LS) en base a un digital elevation
model (DEM) y el factor de préacticas de conservacion de suelos (P) se obtuvo con
la vegetacion alineada a las curvas de nivel. Los resultados obtenidos para la
Region Hidrolégica Pacifico 6 (Region que involucra a la cuenca del rio Tumbes)
muestra una erosion de 30,90 Tn/ha/afio para el periodo de 33 afios (1981-2014),
resaltando los valores mas bajos en los afios de 1989, 1992 y 2004. Concluyendo
gue el factor erosividad (R) es el que tiene mayor influencia en la ecuacion RUSLE,
seguido del factor topografico, debido al relieve pronunciado que incita el
escurrimiento superficial del recurso hidrico conjuntamente con las particulas

arrastradas en los primeros centimetros de la corteza terrestre.

Senamhi (2017) en su estudio AAtl as de

si s

como

er os

del Per 40 aplica | a metodol og?a RUSLE, obt

Hidrogréfica del Pacifico 6 (Regidn que involucra a la cuenca del rio Tumbes) en la
costa norte del Perd. Con niveles de erosion bajo, moderado y alto de acuerdo a la
clasificacion de la FAO; menos de 3,0 Tn/ha/afio (1990 afio seco), 30,90 Tn/ha/afio
y 108,0 Tn/ha/afio (afio 1998) respectivamente.

2.2. MARCO TEORICO
2.2.1. EROSION

La erosion puede definirse ampliamente como un proceso por el cual el suelo es

arrastrado por accion de agentes como el agua y el viento. Esto involucra la
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presencia de dos factores que intervienen en el desarrollo: un elemento pasivo, el
suelo, y un elemento activo, como el agua, el viento o su participacion alterna. Por
otro lado, la cobertura vegetal interactia dando un ajuste a la relacion de estos
factores (Leon, 2001).

2.2.2. TIPOS DE EROSION

2.2.2.1. Erosién de forma natural

Segun ICONA (citado en Perales, 2019) define de la siguiente manera:

A veces se le llama erosién geoldgica porque ocurre de forma natural y gradual,
ocurre durante miles o millones de afos y se desarrolla a través de fenébmenos

naturales.

2.2.2.2. Erosion edlica

La erosion edlica ocurre cuando el suelo desnudo se expone a altas velocidades
del viento. Cuando la velocidad del viento crea un arrastre que es mayor que la
gravedad y la fuerza adhesiva de las particulas, transportando las particulas en un
estado suspendido. Las particulas mas pequefias (0,1-0,5 mm) son resbaladizas o
flexibles con el viento (Ada, 2015).

2.2.2.3. Erosién hidrica

Este tipo de erosion surge a causa del agua de lluvia, produciéndose cuando la
gota de lluvia precipita sobre el suelo descubierto, asi como los procesos
hidraulicos que eliminan y transportan las particulas del suelo de las laderas y
taludes (Figura 1) (CENEPRED, 2014).

FLUJO DE AGUA

Figura 1: Consecuencias del flujo de agua sobre un acantilado 1) situacion inicial, 2) pedazo a
desprenderse, 3) linea de corte y 4) erosion del suelo

27



2.2.3. FACTORES QUE INTERVIENEN EN LA EROSION HIDRICA

(Vasquez et al, 2016) sefiala que los principales factores que se asocian en la

erosion hidrica son los siguientes:

2.2.3.1. EL SUELO

Las propiedades fisicas del suelo, determinan el grado de resistencia a la
separacion y arrastre de los granulos debido a la influencia del agua sobre el suelo,
su potencial de escorrentia y penetracion.

2.2.3.2. LA TOPOGRAFIA

La pendiente y la longitud de la inclinacion son las principales caracteristicas que
influyen en la topografia del terreno, asimismo se ve incluido la forma y tamafio de

drenaje del area involucrada.

2.2.3.3. EL CLIMA

Los factores climaticos persisten en gran medida en el proceso erosivo, tales como
la precipitacion, el viento y la temperatura. Los mismos que estan relacionados
entre si; ya sea el viento al variar su direccion, velocidad y angulo de caida cuando

ocurren las precipitaciones, afectando sobre su fuerza erosiva.

2.2.3.4. LA VEGETACION

La vegetacidon actia como un colchon sobre la superficie, disminuyendo el golpe
del agua, derivado de la lluvia o escorrentia superficial. La cobertura vegetal
protege al suelo mediante: la disminucion de energia de las gotas de lluvia,
disminucion gradual de la velocidad de escorrentia, facilita el transito vertical del
agua debido a la presencia de raices y residuos de la cubierta vegetal, asimismo

las raices entrelazan las particulas del suelo evitando su desprendimiento.

2.2.3.5. EL HOMBRE

El ser humano es el agente principal y decisivo de todos los procesos de erosion,
fundamentalmente por el papel y la participacion de las personas en la gestién y

uso de los recursos naturales.
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2.2.4. ETAPAS DE LA EROSION HIDRICA
2.2.4.1. EROSION

Es el acto de roer y gastar, causando pérdidas significativas y creando vacios,
reduciendo el volumen (SENAMHI, 2017).

2.24.2. TRANSPORTE

Consiste en desplazar el material desgastado de un lugar a otro, ya sea por el
viento, la gravedad, fuertes pendientes, etc. Estos factores aseguran el transporte
(SENAMHI, 2017).

2.2.4.3. ACUMULACION

El material erosionado luego de ser transportado, produce una acumulacion,
presente en la parte inferior de una laguna o el océano (llamado sedimentacion)

alterando o modificando el relieve involucrado (SENAMHI, 2017).

Desagregacién

Figura 2: Representacién del proceso de erosion: Desagregacion, Transporte y Sedimentacion.

2.2.5. PERDIDA DE SUELO POR EROSION HIDRICA (A)

(Nufez, 2001) Menciona que las pérdidas aceptables o los niveles de erosion,
manejados de manera objetiva, pueden ser una herramienta valiosa para identificar
problemas de erosién y seleccionar métodos de control para minimizar los dafios.
Por supuesto, la disminucion del suelo tolerable consiste en las condiciones del
suelo: si es un suelo con una profundidad considerables y fertilidad constante en
todo su corte transversal, entonces la pérdida de 25 mm en 30 afios en un suelo
superficial serd& mucho menor. En esta situacion, el valor maximo rara vez supera

las 12,5 Tn/ha*afio; y suele ser menos.
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Tabla 1: Niveles de pérdida de suelo en la ecuacion USLE (Universal Soil Loss Equation)

intensidad de amenazas pérdida de suelo (Tm/h&afio)

Baja Menor a 5
Moderada 5-25
Media 2550
Alta 50-100
Muy alta 100200
Critica Mas de 200

Fuente: Adaptado de FAO, UNESCO, PNUMA (1 980), citado por
EDESO (1 997), RAMOS (2001, 2009), VELASQUEZ, S (2 008) y
RAMIREZ, L (2 010

2.2.6. EROSION HIDRICA POTENCIAL Y ACTUAL

(Susana, 2010) menciona, que la erosién hidrica potencial hace referencia al
desarrollo de sus factores en un area especifica por accion de mediadores como el
clima, suelo y relieve. En este caso de erosion se excluye la accion humana y

cobertura vegetal.

Por otro lado, cuando hablamos de erosion hidrica actual o real, involucra el fator

cobertura vegetal y manejo, y el factor de practicas de apoyo a la conservacion.

2.2.7. ECUACION UNIVERSAL DE PERDIDAS DE SUELOS REVISADA
(RUSLE)

La AEcuaci-n Universal icdadR®r gpioda sdes Sugll as
una revision y actualizacion de USLE, utilizada ampliamente desde principios de la

década de 1960 y su primera version se describio en Agriculture Handbook N° 282,

publicado en el afio 1965; mientras que su segunda version principal se describio

en Agriculture Handbook N° 537, publicado en 1978. RUSLE es su tercera version

y se describe en el Manual de Agricultura N° 703, publicado en 1996 por el
Departamento de Agricultura de los Estados Unidos de América, Washington D.C.

y conserva -hasta cierto punto- la estructura de ecuaciones de USLE (Camacho et

al 2022).

La ecuaciéon RUSLE esta expresa y compuesta en el sistema métrico internacional

(SI) por los factores siguientes:
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0 YD WD (1)

Donde:

A : Es la pérdida de suelo promedio anual (ton-ha*-afio™).

R : Factor de erosividad de las lluvias (MJ-mm-ha*-hrt-afio™).

K : Es el factor de erodabilidad del suelo (ton-ha-hr-hat-MJ1-mm-).

LS : Factor topogréafico de la longitud L y pendiente S (adimensional).

C : Factor de cobertura vegetal del area de estudio (adimensional).

P : Es el factor de conservacion de la estructura del suelo (adimensional).

2.2.7.1. FACTOR DE EROSIVIDAD DE LA LLUVIA (R)

La energia cinética con la que precipita la lluvia produce erosion, desuniendo los
granulos de suelo, compactando la superficie y produciendo escorrentia superficial
cuando el suelo llega a la saturacion (supera su capacidad de infiltracion)
(Gonzales, 1991).

Y ‘000 (2)
Siendo E la energia de la lluvia determinada a su vez por la formula:
O ¢plm Ydae QO 3)

E : Es la energia cinética de la lluvia (julios/m2 por cm de lluvia)
I : Es la intensidad maxima de lluvia (cm/h)

30 . es la intensidad maxima en treinta minutos de lluvia (cm/h).

En muchos casos los escases de datos, nos induce a aplicar nuevas metodologias
para determinar este factor, en este caso Wischmeir y Smith (1978) desarrollan la

siguiente formula:

Y ply o @p 1" 7 h (4)
Donde:
R : Factor de erosividad de lluvias (MJ-mm-ha-hrt.afio?).
Pi : Precipitacion mensual (mm).
p : Precipitacion anual en (mm).
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Tabla 2: Niveles de erosividad (R)

MJI*mm/Ha*Hrs*afio Factor R

0¢50 Bajo

50¢ 550 Moderado
550¢ 1000 Alto
Mayor a 1000 Muy Alto

Fuente: indice de Fourier, citado por
(Moreno, 2017)

2.2.7.2. FACTOR DE ERODABILIDAD DEL SUELO (K)

El factor K expresa la vulnerabilidad del suelo al desprendimiento y transporte de
sus particulas, influenciada por las propiedades fisicas (textura, estructura, materia
organica, etc.) este factor se evalia en un rango de 0 a 1, el primero sefiala una
pequeia incidencia de erosion mientras que 1 sefiala suelos muy propensos a la
erosion por el recurso hidrico (SENAMHI, 2017).

Teniendo los datos de textura, estructura, permeabilidad y materia organica se
puede determinar el factor K, mediante la ecuacion de Wischmeier y Smith en 1978,

gue se presenta a continuacion:

priot cpd 8 pm pg & oftuvw ¢ CB® o (5)
Donde:
M : (% limo + % arena muy fina) * (% limo + % arena - % arena fina)
a : % de materia organica
b : Parametro de tipo de estructura de suelo
Cc : Clase de permeabilidad

Asimismo, Sharpley y Williams (1990), nos dicen que teniendo los datos de textura
y materia organica en la capa superficial del suelo se puede determinar el factor K

en base a las siguientes ecuaciones:

0 QO O OQ (6)
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Donde:
. . . a
nQ ,\A -E) n oy ”n
g TowADD g vepa w p —pnTr (8)
a h
"Q -~ . 9
PR (9)
mig uDE i QO
Q = o 1
P Q6A @élx v choudé | "QO (10)
- . a
mXw p 53
Q p 5 —P R (11)
P omin A@Dul p ¢ oo p DT
ms  : % de contenido de fraccion de arena (g de 0,57 2 mm)
msit  : % de contenido de fraccion de limo (g de 0,002 7 0,05 mm)
mc : % de contenido de fraccion de arcilla (g < 0,002 mm)

orgC : % de contenido de fraccion de carbono organico

2.2.7.3. FACTOR DE LONGITUD DE LA PENDIENTE E INCLINACION (LS)

Este factor representa longitud de la pendiente y esta vinculado con el factor de
inclinaci-n ASO, estos factores influyen c

la pendiente es mayor que la velocidad de escurrimiento (Caycho, 2020).

Desmert y Groves (1996) presentan la siguiente metodologia para obtener el factor

LS, a través de estas ecuaciones:

. 12
O 2 Y (12)
) © 13
& 50 (13)
"0 i QMM Y we (14)




Para su uso dentro de los SIG se hace uso de la ecuacion:

. op ©O 0
0 o —— —— (15)
w O ¢ @
Donde:
L : Factor de longitud
b : pendiente a nivel de pixel
m . pendiente
F : factor en funcion de la pendiente
D : Tamano de pixel (cell cize)
X : Coeficiente de forma (x = 1 para sistemas pixeleados)
determinado L, se determina el factor S, mediante la siguiente ecuacion:
™ p AR N& Tmmo o GEp T 16
T N TR oY TR SRt (16)
Tabla 3: Clasificacion del factor LS
Factor LS Categorizacion
Bajo <15
Moderado 1530
Alto 3045
Muy Alto >45

Fuente: Instituto Espacial Ecuatoriano (IEE)
citado por (Moreno, 2017)

Tabla 4: Valores de LS en funcion a la pendiente

Grupos de pendientes en % Factor L.S

0-3 0,3
3-12 15
12-18 34
1824 5,6
24-30 8,7
30-60 14,6
60-70 20,2
70-100 25,2
>100 28,5

Fuente: Tomado de Ramos Taipe (2001) citado por
(Caycho, 2020)
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2.2.7.4. FACTOR DE COBERTURA DE SUELO (C)

Conocido como factor de vegetacion, representa la efectividad que tiene la cubierta
vegetal para proteger al suelo de la energia de impacto de las gotas de lluvia y la
fuerza del flujo superficial, la cual es adimensional. En USLE, el factor C es
calculado usando ecuaciones empiricas que contienen mediciones de campo de la

cobertura del suelo (Camacho et all, 2022).

Para determinar el factor C a partir de datos de teledeteccion, utilizamos dos
métodos ampliamente utilizados basados en el indice de Vegetacion de Diferencia
Normalizada (NDVI). Varia de 1 a -1, representando los valores mas altos a una
zona con mayor cobertura vegetal (Almagro et all, 2019)

L00OYYOO

) O 17
506 G v Yo0 e

Tabla 5: Clasificacion de los valores de NDVI

Clasificacion Valor
Nubes y agua (NA) <001
Suelo sin vegetaciéon (SV) 0,01-0,1
Vegetacion ligera (VL) 0,1-0,2
Vegetacién mediana (VM) 0,2-0,4
Vegetacion alta (VA) >04

Fuente: (Lépez et all, 2015)

(Almagro et al ,2019) en su articulo de investigacion plantea las siguientes

ecuaciones para el calculo del factor C:

a) Enfoques de teledeteccion

6 Tmip —— (18)

6 Q (19)

35



El primer método utilizado para estimar el factor C fue propuesto por Durigon et al.
(2014) y adaptado por Colman (2018) (Cra), Y el segundo por van der Knijff et al.
(1999) (Cwk). El Cia y Cuk son calculado siguiendo las Ecuaciones (18) y (19),

respectivamente.

El Cia se basa en el resultado del NDVI en condiciones de clima tropical, con
precipitaciones mas intensas. En relacion con Cvk, Van der Knijff, Jones y
Montanarella (2000) concluyeron que, para las condiciones climéaticas Europeas,
los valores 2 y 1 son los mejores representantes de los parametros de la ecuacion
Uy b, respectivament e.

b) Enfoque tradicional

Mediante la consulta de literatura del factor C de acuerdo al tipo de cobertura

vegetal.

2.2.7.5. FACTOR DE PRACTICAS DE MANEJO (P)

Conocido como medidas de conservacion, pone en evidencia la eficiencia del
control de la erosion lograda con la implementacion de las medidas de conservacion
de suelos. Este factor adopta diferentes valores en funcion del tipo de practica y
pendiente sobre la que se encuentra; y, cuando no se han implementado practicas

conservacionistas se le asigna el valor de 1 (Camacho et al, 2022).

2.2.8. TELEDETECCION

Es una técnica con la que se obtiene informacién a distancia sin interactuar con el
material, el Unico vinculo que establece con los objetos observados es mediante
sensores y plataformas ubicados en la superficie terrestre, marina o atmosfera, ya

sean satélites, aeronaves, servidores, etc.) (Alonso, 2014).

2.2.9. SISTEMA DE INFORMACION GEOGRAFICA

Este sistema permite integrar varias bases de datos geoespaciales e implementar
varias técnicas para el proceso de datos, relacionando con actividades del espacio,

vinculado con el trabajo SIG (Alonso, 2014).

Las ventajas que presentan los sistemas de informacion geogréaficas al momento

de determinar la erosién, son varias, algunas de esas son las siguientes:
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1 Procesar abundantes datos permitiendo calcular variables relacionadas en
el modelo, obteniendo resultados en capas, factores o ecuaciones
matematicas.

1 Ejecutar operaciones, distribuir los resultados espacialmente creando

escenarios posibles y con ello mostrar de una manera clara los resultados.

Para implementar estas técnicas de SIG y optimizar los resultados, es conveniente
hacer uso de software ArcGis, mediante sus herramientas o nuevas incorporadas

por el usuario (Zeiler, 1999) citado por (Caycho, 2020).

2.2.10. EL MODELO RASTER

Representa imagenes digitales mediante mallas divididas en filas y columnas
(pixels). Cada celda ha de ser rectangular, aunque no necesariamente cuadrada,
cada una de ellas representa un valor en el sistema proyectado. Los formatos mas

utilizados son: Jpg, png, tiff (Alonso, 2014).

2.2.11. MODELO VECTORIAL

Este modelo es representado mediante vectores, que en conjunto van formando un
todo, por ejemplo, a partir de un par de coordenadas y su altitud se generan puntos,
estos a su vez generan una linea, y estas agrupadas forman poligonos (Alonso,
2014).
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CAPITULO Il
3. MATERIALES Y METODOS
3.1. UBICACION

El proyecto se realizara en la cuenca del rio Tumbes, que forma parte de la vertiente
del pacifico.

3.1.1. UBICACION GEOPOLITICA

Tabla 6: Ubicacion politica de la cuenca del rio Tumbes

Regién Provincia Distritos
Pampas de Hospital, San Jacinto, San
Tumbes .
Tumbes Juan de la Virgen, Corrales, Tumbes
Zarumilla Matapalo

Fuente: (ANA, 2022) https://snirh.ana.gob.pe/observatorioSNIRH/

3.1.2. UBICACION GEODESICA

Tabla 7: ubicacién geodésica de la zona de estudio
ESTE(X) (M) NORTEC(Y) (m)

56111Q00 961341000
53792500 953317500
59694000 956960700
54520900 957679700

Fuente: Elaboracién propia (2022)
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Figura 3: Mapa de ubicacion de la zona en estudio.
Fuente: Elaboracion propia
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3.2.

MATERIALES Y EQUIPOS

3.2.1. MATERIALES

il

Registro de precipitacion acumulada mensual (20001 2022).
Para célculo del factor R

Fuente:
1 https://www.senamhi.gob.pe/?p=estaciones
1 Proyecto Especial Binacional Puyango Tumbes (PEBPT)

Informacién vectorial de las cuencas hidrograficas de Tumbes (Shapefile).
Para delimitar la zona de estudio.

Fuente:
1 https://snirh.ana.gob.pe/ObservatorioSNIRH/

Informacion raster de textura de suelos en formato GeoTif.
Para calculo del factor K

Fuente:
1 https://soilgrids.org/

Modelo de elevacion digital (DEM) AsterDem.
Para el calculo del factor LS.

Fuente:
i https://geoservidorperu.minam.gob.pe/geoservidor/download raster.aspx

Capa vectorial de carreteras, centros poblados, departamentos, provincias y
distritos.
Para identificar zonas con riesgo de erosion hidrica.

Fuente:
1 https://www.geogpsperu.com/

Imagenes satelitales LANDSAT en formato GeoTif.
Para célculo del factor C.

Fuente:
1 https://earthexplorer.usgs.gov/ aios: 2000, 2005, 2010, 2015 y 2020.

Libreta de apuntes

control de informacion.

Lapices, lapiceros, regla y borrador

Para apuntes pertinentes.
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3.2.2. EQUIPOS

GPS Garmin E20
Disco externo 1TB

Smartphone
Laptop Hp Core i7

Impresora

3.2.3. SOFTWARE

"
"
i
i

c:

QGis

ArcGis

Google Earth Pro
Hec 4

R Studio
Paquete Office
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3.3. PROCEDIMIENTO METODOLOGICO

l CLIMA I

v
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A
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extension
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formula R
(Wischmeir y
Smith)

!
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Figura 4: Esquema metodoldgico de la erosién hidrica actual y potencial.
Fuente: Elaboracion propia.



3.3.1. RECOPILACION DE LA INFORMACION BASICA

Durante la etapa inicial, se llevo a cabo la recopilacion de informacion en la zona
de investigacion, la cual es fundamental para la creacion de los modelos

geoespaciales.

3.3.1.1. Precipitacién media mensual

Se requiere esta informacion para calcular el Factor de Erosividad (R), en un rango
de 23 afos de registros (2000 i 2022), esta informacién fue obtenida de manera
gratuita a través del Servicio Nacional de Meteorologia e Hidrologia (SENAMHI) y

el Proyecto Especial Binacional Puyango Tumbes (PEBPT).

La informacion por parte del SENAMHI se encontr6 disponible en la pagina web:

https://www.senamhi.gob.pe/?p=estaciones,por otro lado, el PEBPT brindd los

datos a través de correo electronico, asimismo se requirio la extraccion de data del
producto PISCO precm para generar dos estaciones virtuales en las areas mas
altas y alejadas de la zona de estudio para una mejor interpolacion, este producto
se obtuvo en la pagina web
https://iridl.Ideo.columbia.edu/SOURCES/.SENAMHI/.HSR/.PISCO/?Set-

Language=es e n

f or maadl scripfide pregtamacion R fue empleado para la

extraccion de los datos de precipitacion, queda especificado en el (Anexo 10). Las

estaciones consideradas para el estudio se detallan en la (Tabla 8) y (Figura 5).

Tabla 8: Estaciones consideradas en el estudio.

Coordenadas Altitud
Estacién Tipo Provincia Distrito UTM (m.s.n.m)
Este (m) Norte (m) T
CamSp:(;r;ento Automatica-Met. Tumbes Tumbes 563348,76 9607466,65 17
La Cruz CO”"&Z‘;'O”""" Tumbes LaCruz  547834,86 9598948,00 6
ElTigre ~ convencional  p hes Pampas de  genao6 10 9579702,76 45
Met. Hospital
CaboInga  Automatica-Met. Tumbes San Jacinto  566404,90 9560507,87 231
~ -~ Contralmirante .
Canaveral Automatica-Met. Villar Casitas 538790,33 9564596,40 133
Matapalo Automética-Met. Zarumilla Matapalo 589005,60 9592898,63 62
V1 Virtual Tumbes San Jacinto  547718,00 9541864,00 972
. Pampas de
V2 Virtual Tumbes ) 584310,00 9567166,00 527
Hospital

Fuente: Elaboracion Propia
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Figura 5: Mapa de estaciones consideradas en el estudio
Fuente: Elaboracién Propia

Los datos de precipitaciones mensual total de las estaciones involucradas se

encuentran en el (Anexo 1).

Analisis de consistencia de datos de precipitacion

Una vez que se ha recolectado la informacion, es importante validarla, procesarla
y resumirla para crear un "producto elaborado" que pueda ser utilizado en el

estudio. Es por eso que previo a la utilizacion de estos datos se le debe realizar el

proceso descrito en la (Figura 6).
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Figura 6: Flujograma para el tratamiento de la informacién Hidrometereol6gica
Fuente: Adaptado de Hidrologia Estadistica, Maximo Villén Béjar

a) Analisis visual grafico

Segun (Villén, 2006) la informacion hidrolégica historica se representa en un gréfico de
coordenadas cartesianas, en el que se ubican los valores de la serie en el eje Y y el
tiempo (afios, meses, dias, etc.) en el eje X. Esta visualizacion inicial permite una
evaluacion preliminar de la calidad y precision de la informacion, antes de proceder a

un andlisis mas detallado mediante la técnica de doble masa. (Anexo 2).

HIDROGRAMA PRECIPITACION ESTACION "CAMPAMENTO SEDE"

—— Precipitacion acumulada mensual (mm)
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&

&

g 5, 2, %, 4 9 4 o 4,
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&
-«
&

PERIGDO 2000-2022)

Figura 7: Andlisis visual de 23 afios de precipitacion histérica
Fuente: Elaboracién propia

44



b) Analisis doble masa

En este apartado se agrupan las estaciones ploteando en el eje de las abscisas los
acumulados, de estos doble masa se selecciona la estacion mas confiable, la que
presenta el menor nimero de quiebres (y con esta estacidon se vuelven a elaborar
diagramas de doble masa colocando en el eje de las abscisas la estacion base y

en el de las ordenadas la estacion en estudio (Anexo 3).

Acumulado de 4

la eslacion
en estudio

»

n1 n2 n3 Acumulado de la

estacion base

Figura 8: Andlisis doble masa para obtener los periodos de estudio (en este caso nl, n2, n3)
Fuente: (Villén, 2006)

De estos graficos se sacan los periodos dudosos para cada estacion, la misma que

sera tratada con los criterios estadisticos.
c) Analisis estadistico

flLuego de obtener los graficos para el analisis visual y los datos de doble masa, se
identifican los periodos en los que se podrian presentar correcciones y se
determinan los periodos en los que los datos mantendran sus valores originales. A
continuacion, se realiza un analisis estadistico de la media y la desviacion estandaro
(Anexo 5). (Villon, 2006).

d) Completacion y extension

La complementacion de datos se refiere a llenar los espacios vacios que aparecen
en un conjunto de datos. Este proceso es considerado una forma especifica de
extension, ya que se alteran los calculos de los parametros poblacionales. El
modelo de regresién simple es el método matematico mas comun utilizado para
transferir informacion hidrolégica entre estaciones medidas; en este caso se utilizd

el programa HEC i 4 para dicho procedimiento (Anexo 6).
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3.3.1.2. Modelo Digital de Elevacion (DEM)

Se requiere esta informacion para calcular el Factor 7 LS, la informacion fue
extraida del Geoservidor del Ministerio del Ambiente (MINAM)
https://geoservidorperu.minam.gob.pe/geoservidor/download raster.aspx Se ha

generado un mapa topografico denominado ASTER GDEM (Aster Global Digital
Elevation Model utilizando 1,3 millones de imagenes estéreo obtenidas mediante el
radiometro japonés ASTER. Este mapa se encuentra disponible gratuitamente para
usuarios de todo el mundo y tiene una resolucién espacial de 30 metros. El mapa
hace referencia al geoide WGS84/EGM96, tal como se evidencia en la (Figura 9).
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Figura 9: Mapa de cobertura de imagenes ASTER (DEM)
Fuente: Ministerio del Ambiente (MINAM)
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3.3.1.3. Textura (Arcilla, limo y arena) y materia organica (Mo)

Se requiere esta informacion para calcular el Factor i K, para este estudio se utilizé
la informacion provista por el SoilGrids de forma gratuita en la pagina web:
https://soilgrids.org/ iest e servidor produce mapas de |

para todo el mundo a una resoluci-n espaci é

(Poggio et al., 2021), la extension de descarga es en formato raster Geotiff.

< C (Y @ soilgridsorg G W aerwx 00 'l‘f 3

DOWNLOAD DATA

SolGrids

Figura 10: Interfaz de la pagina del SoilGrids
Fuente: SoilGrids

3.3.1.4. Iméagenes LANDSAT

Se requiere esta informacion para calcular el Factor i C, estas imagenes fueron
obtenidas de manera gratuita por el Servicio Geoldgico de los Estados Unidos

(USGS por sus siglas en inglés) en la pagina web: https://earthexplorer.usgs.gov/

.el criterio de descarga se realiz6 en dos temporadas (Tabla 9), en el rango de
estudio (2000 i 2022) cada 5 afios (Tabla 10), con una cobertura de nubes <20%.

Tabla 9: Temporadas de adquisicion de imagenes satelitales

Temporada Himeda (veraneotofio) Temporada Seca (invierngprimavera)

22 -dic., Enero, Febrero, Marzo 22-jun., Julio, Agosto, Setiembre
Abril, Mayo, 2% Jun. Octubre, Noviembre, 24Dic.
Fuente: Elaboracion propia
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Tabla 10: Caracteristicas de las imagenes satelitales utilizadas

Resolucion Fecha de lg o
Imagen Sensor . Escena Temporada Localizacion
Espacial Imagen

011- 062
Ol1.0p3 14/1012000

11- 062

811-823 31/05/2000 Tumbes
Landsat7 ETM+ 30 mtX 30 mt .,

011-062 " »5/19/2000 Peru

011-063

011- 062

011-063

011- 062

011-063

11- 062

311-323 04/12/2004 Tumbes
Landsat7 ETM+ 30 mtX 30 mt .,

011-062 " »4/05/2005 Perd

011-063

011- 062

011-063

011- 062

011-063

11- 062

811-823 19/09/2010 Tumbes
Landsat7 ETM+ 30 mtX 30 mt .,

011062, 4103/2010 Perd

011-063

011-062

011-063

011-062

011-063

811822 07/08/2016 Tumbes
Landsat8 OLI/TIRS 30 mt X 30 mt §

011-062 ) /6972015 Peru

011-063

011-062

011-063

011-062

011-063

81182\’2% 02/08/2020 Tumbes
Landsat 8 OLI/TIRS 30 mt X 30 mt .

011-062 ", 2/06/2020 Perd

011-063

011-062

011- 063

Fuente: Servicio Geoldgico de los Estados Unidos (USGS)

Seca

Humeda
23/05/2000

07/10/2006
Seca

Humeda
16/05/2006

02/10/2010
Seca

HUimeda
11/05/2010

24/10/2015
Seca

Hlimeda
13/02/2016

17/07/2020
Seca

HUumeda
17/05/2021

Procesamiento digital de imagenes satelitales

Las imagenes satelitales tanto Landsat 7 y 8 han sido descargadas de la coleccién

2 nivel 1 (Landsat collection 2 level -1), incluyendo las siguientes correcciones:
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Iméagenes Landsat 7

Correccion atmosférica: Esto implica la eliminacion de los efectos de la
atmosfera en la imagen. Los gases atmosféricos y el polvo pueden causar
distorsiones en la imagen, lo que puede hacer que sea dificil interpretarla
correctamente

Correccion de la geometria: Esto implica ajustar la imagen para que sea
geogréaficamente precisa. Esto se hace corrigiendo los errores en la posicion
y la orientacion de la imagen.

Correccion topogréfica: Esta correccion se realiza para corregir las
variaciones topograficas en la imagen. Los cambios de elevacién pueden
causar distorsiones en la imagen, lo que puede hacer que sea dificil

interpretarla correctamente.

Imagenes Landsat 8

Presenta las mismas correcciones que las Landsat 7 incluyendo:

Correccion de la posesion del sol: Esta correccion se realiza para ajustar la
imagen a la posicion exacta del sol en el momento en que se tomo la imagen.
Correccion de banda espuria: Esta correccion se realiza para eliminar los
artefactos de las imagenes que pueden ser causados por la interferencia de

las sefales de la Tierra.

a) Correccion por bandeamiento

Esta correccion se les aplico a las imagenes del Landsat 7, en los afios 2005 y

2010, ya que el 31 de mayo de 2003, el Corrector de Escaneo Lineal (SLC), que

compensa el movimiento de avance del Landsat 7, fracaso. Sin un SLC operativo,

el Thematic Mapper Plus (ETM +) de la linea de visidn mejorada ahora traza un

patron de zig i zag a lo largo de la pista de tierra por satélite.

Para corregir este bandeamiento, se utilizé el Software libre Q-Gis haciendo uso de

la correccidn sin datos, cuya direccion es Raster > Analisis > Rellenar Sin Datos.
(Figura 11).
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Figura 11: Entorno de Q-Gis aplicando la correccion por bandeamiento.
Fuente: Elaboracion propia

Figura 12: Resultado de la correccién por bandeamiento.
Fuente: Elaboracién propia

Este procedimiento fue aplicado a todas las imagenes obtenidas del Landsat 7,

especificamente para la banda 3 y 4.
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3.3.2. APLICACION DEL MODELO (RUSLE)

Una vez que hemos descargado y registrado los datos espaciales geograficos en
la base de datos, tal como se indica en el punto 3.3.1, podemos comenzar a trabajar

en gabinete y, por ende, avanzar con la investigacion.

La metodologia RUSLE, que ha sido mencionada en diferentes secciones del
documento, se compone de 5 factores que deben ser tratados en procesos

individuales y posteriormente combinados mediante una multiplicacion final.

3.3.2.1. Obtencién del factor climético, erosividad (Factor R)

Para su determinacion se utilizé informacién de precipitaciones procedentes de las
estaciones detalladas en la (Tabla 8), una vez realizado el andlisis de consistencia
(Anexo 5) de la informacion se procedio a aplicar la ecuacion desarrollada por
(Wischmeier & Smith,1978) Ec.(4), La formula requiere de dos variables: la
precipitacion mensual y la precipitacion anual, que es la suma de las 12
precipitaciones mensuales de cada afo. Para agilizar el proceso, se emple¢ el

programa Excel (Anexo 9).

Una vez calculado el factor R para cada uno de los afos de estudio (23 afios), se
hizo uso del Software ArcGis 10.5 para realizar la interpolacion con la herramienta

IDW (Peso Inverso de la Distancia) con el siguiente proceso:

a) Se cargaron | as estaciones al Ar.cNMap,0,eXx|
seguidamente se realizd la interpolacion ArcToolbox > Spatial Analyst

Tools > Interpolation > IDW.

b) Realizada la interpolacion se obtiene un raster sobresaliente al area de
influencia por lo que es necesario recortar ArcToolbox > Spatial Analyst

Tools > Extraction > Extract By Mask.

c) Finalmente, para una mejor interpretacion se procedi6 a reclasificar en rangos
adecuados de acuerdo al minimo y mayor valor ArcToolbox > Spatial

Analyst Tools > Reclass > Reclassify. Mapas en (Anexo 15 - 38)
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Figura 13: Uso de ModelBuilder para calcular el Factor R - (afio 2000)
Fuente: Elaboracion propia

3.3.2.2. Obtencion del factor suelo (Factor K)

Para este estudio se requirié informacion de porcentaje de arena, arcilla y limo
(textura) y materia organica (M.O) como se precisa en el item 3.3.1.3, esta
informacion es primordial para hacer uso de las férmulas propuestas por Sharpley
y Williams (1990). Se utilizé el software ArcGis 10.5 desarrollando el siguiente

proceso:

a) Teniendo los archivos raster de la textura y materia organica, se procede a
realizar un ABuffero (el dobl e del pi xel

pérdidas de informacion ArcToolbox > Analisis Tools > Proximity > Buffer.

b) EI vector obtenido con el ABuffero ser§
procede a recortar los raster ArcToolbox > Spatial Analyst Tools >
Extraction > Extract By Mask y le damos <Batch> para hacer un recorte

multiple.

c) Conlosrasterr ecortados se realiza una Ol traci

ArcToolbox > Spatial Analyst Tools > Extraction > Extract By Attributes.
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d)

f)

g)

h)

)

k)

Al presentarse vacios de informacion en los raster, realizamos un relleno de
informacion ArcToolbox > Spatial Analyst Tools > Neighborhood > Focal
Statistics.

Seguidamente se realiza una conversion de decimales haciendo uso de la

calculadora réster ArcToolbox > Spatial Analyst Tools > Map Algebra >

Raster Calculator. Argumento de ecuacién: (Float( ALi mo1C. Tl1 Fo) / 10)

Teniendo todos estos procesos, c al c ul a 06 ld Ec.(8) para ello
utilizamos la calculadora raster ArcToolbox > Spatial Analyst Tools > Map
Algebra > Raster Calculator. Argumento de ecuacion:
(0.2+0.3*Power(2.71828182845905,(0.256*"ARENA1D.TIF"*(1"LIMO1D.TIF"
/100)))).

Cal cul amfo sc dbE(9) AacToolbox > Spatial Analyst Tools > Map
Algebra > Raster Calculator. Argumento de ecuacion:
Power(("LIMO1D.TIF"/("ARCILLA1D.TIF"+"LIMO1D.TIF")),0.3)

Cal cul axio s ofetH10) &rcToolbox > Spatial Analyst Tools > Map
Algebra > Raster Calculator. Argumento de ecuacion: (1-
(0.25*"CARBONOLD.TIF"/("CARBONO1D.TIF"+Power(2.71828182845905,(
3.75-2.95*'CARBONO1D.TIF")))))

Cal cul angdfis cfiodac.(1l)aArcToolbox > Spatial Analyst Tools >
Map Algebra > Raster Calculator. Argumento de ecuacion: (1-((0.7*(1-
"ARENA1D.TIF"/100))/((1"ARENA1D.TIF"/100)+Power(2.71828182845905,(
5.51+22.9%(1-"ARENAL1D.TIF"/100))))))

Cal cul adw® sc da&(6) AacToolbox > Spatial Analyst Tools > Map
Algebra > Raster Calculator. Argumento de ecuacion:
"Fhisand.tif"*"Forgc.tif"*"Fcl-si.tif"*"Fcsand.tif"

Cal cul awed s c 6Bk.(7) AacToolbox > Spatial Analyst Tools > Map

Algebra > Raster Calculator. Argumento de ecuacion: "Kusle.tif"*0.1317

Finalmente recortamos el raster a nuestra area de estudio ArcToolbox >
Spatial Analyst Tools > Extraction > Extract By Mask. Mapa en (Anexo
39)
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Figura 14: Uso de ModelBuilder para calcular el Factor K

Fuente: Elaboracion propia.

=) FACTORK
(Tn.ha.h)/(MJ.mm.Ha)
[]0.01406 - 0.01483
[10.01484 - 0.0152
[ 0.01521 - 0.01548
[ 0.01549 - 0.01579
[ 0.0158 - 0.01633

Figura 15: Representacion grafica del Factor K
Fuente: Elaboracién propia

3.3.2.3. Obtencion del factor relieve (Factori LS)

Para hallar este factor, se utilizaron las imagenes ASTER GDEM obtenidas del
MINAN como se precisa en el item 3.3.1.2 , previo a esto también se pobo con el
DEM SRTM proporcionado por la USGS, pero las correcciones eran mayores ya
gue presentaba valores negativos. Teniendo esta informacion ya se puede hacer

uso de las formulas planteadas por Desmert y Groves (1996), Se utilizo el software

ArcGis 10.5 desarrollando el siguiente proceso:
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a)

b)

d)

f)

g9)

h)

)

Ya que la zona de estudio abarca dos cuadrantes (S04W81 y SO5W81) es
necesario unir ArcToolbox > Data Management Tools > Raster > Raster
Dataset > Mosaic To New Raster.

Una vez unidos los dos cuadrantes realizamos una correccion por relleno

ArcToolbox > Spatial Analyst Tools > Hydrology > Fill.

Realizado el relleno de informacion se procede a recortar de acuerdo al area
de estudio ArcToolbox > Spatial Analyst Tools < Extraction < Extract By
Mask.

Luego procedemos a calcular la pendiente en grados, este vendria a ser mi
valor de b (pendiente a nivel de pixel) ArcToolbox > Spatial Analyst Tools
> Surface > Slope.

Ya con el raster de pendientes se utilizala Ec.(14)par a encontrar fAF
resaltarqueab se | e multiplica por O0.01745 pa
radianes ArcToolbox > Spatial Analyst Tools > Map Algebra > Raster

Calculator. Argumento de ecuacion:
(SINn("BETA.TIF"*0.01745)/0.0896)/(3*Power(Sin("BETA.TIF"*0.01745),0.8)

0.56)

Luego para encontr ar E@(AB) ArsTeolbbxa>xSpatials o de
Analyst Tools > Map Algebra > Raster Calculator. Argumento de ecuacion:
"F.TIF'/(1+"F.TIF")

Seguidamente calculamos la direccion del flujo con el raster corregido por fFillo

ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Direction.

Seguido de aquello calculamos la acumulacion del flujo ArcToolbox > Spatial

Analyst Tools > Hydrology > Flow Acumulation.

Por consiguiente, calculamos el Factor de longitud (L) de acuerdo a la Ec.(15)
ArcToolbox > Spatial Analyst Tools > Map Algebra > Raster Calculator.
Argumento de ecuacion:
(Power(("FLOW_ACUM.TIF"+30.79*30.79),("m.TIF"+1))Power("FLOW_ACU
M.TIF",("m.TIF" + 1))) / (Power(30.79,("m.TIF" + 2)) * Power(22.13,"m.TIF"))

Luego calculamos en factor S de acuerdo a la Ec.(16) ArcToolbox > Spatial

Analyst Tools > Map Algebra > Raster Calculator. Argumento de ecuacion:
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Con(Tan("BETA.TIF"*0.01745)<0.09,10.8*Sin("BETA.TIF"*0.01745)+0.03,16
8*Sin("BETA.TIF"*0.01745)-0.5)

kl Ahora teniendo ALO y #AS0 pSAra@aotbhex >a cal ¢
Spatial Analyst Tools > Map Algebra > Raster Calculator. Argumento de
ecuaci - n: AFACTOR S.TIFO0O*O0OFACTOR L. TI FO

l) Finalmente le damos el valor de celda (pixel) con el que se esté trabajando
(100 m X 100 m) ArcToolbox > Data Management Tools > Raster >
Resample. Mapa en (Anexo 40).
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Figura 16: Uso de ModelBuilder para calcular el Factor LS
Fuente: Elaboracién propia

5 @ FACTORLS
[C1<5BAJO
[15-10 MODERADO
[Z110-20 MEDIANO
[ 20-50 ALTO
[ 50-100 MUY ALTO
I >100 CRIMICO

Figura 17: Representacion gréfica del Factor LS
Fuente: Elaboracién propia
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3.3.2.4. Obtencion del factor cobertura vegetal (Factor C)

El factor cobertura vegetal se trabajo con las imagenes satelitales obtenidas del
Landsat 7 y 8 como se muestra en el item 3.3.1.4, para ello se utiliz6 la metodologia
planteada por (Almagro et al, 2019), este método nos dice que para obtener el NDVI
de cierto afio se debe considerar las estaciones secas y humedas, es decir que se
procesaron las imagenes satelitales en temporada humedad (verano y otofio) y
temporada seca (invierno y primavera) y con ello promediar el NDVI para dicho afio.
Se utilizo el software ArcGis 10.5 desarrollando el siguiente proceso:

a) Ya que el area en estudio abarca dos escenas es necesario realizar un
mosaico de ambas, cabe mencionar que en todo el proceso se va a trabajar
Unicamente con dos bandas (B3 yB4 para Landsat 7 y B4 y B5 para Landsat
8) ArcToolbox > Data Management Tools > Raster > Raster Dataset >
Mosaic To New Raster.

b) Seguidamente realizar el calculo del NDVI con la Ec.(17), este procedimiento
va a depender del satélite ArcToolbox > Spatial Analyst Tools > Map
Algebra > Raster Calculator. Argumento  de  ecuacion:
Float("B4_H_CT.TIF"-"B3_H_CT.TIF")/Float("B4_H_CT.TIF"+"B3_H_CT.

c) Teniendo los NDVI para cada temporada, le sacamos el promedio
ArcToolbox > Spatial Analyst Tools > Map Algebra > Raster Calculator.
Argumento de ecuacion: ("NDVI_S.TIF"+"NDVI_H.TIF")/2

d) Ahora calculamos el factor C de acuerdo con la Ec.(18) ArcToolbox > Spatial
Analyst Tools > Map Algebra > Raster Calculator. Argumento de ecuacion:
0.1*((-"NDVI_2000.TIF"+1)/2).

e) Finalmente le damos el valor de celda (pixel) con el que se esta trabajando
(100 m X 100 m) ArcToolbox > Data Management Tools > Raster >

Resample. Mapas en (Anexo 41 - 45).
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Figura 18: Uso de ModelBuilder para calcular el Factor C
Fuente: Elaboracion propia

= M FACTORC
<0.03149
[10.03149 - 0.03669
[10.03669 - 0.04189
[10.04189 - 0.04969
[ >0.04969

Figura 19: Representacion gréfica del Factor C i (Afo 1 2000)
Fuente: Elaboracién propia
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3.3.2.5. Obtencién del Factor P

En varios estudios realizados en cuencas y microcuencas en el Peru, se da 1 como
valor para el factor P, debido a que no se cuenta con la informacion necesaria de
estas practicas o caso contrario no se hacen, es asi que se utilizé este valor 1 para
no reducir la precision de la ecuacion (Peralta, 2016) citado por (Morante &
Gonzales, 2019).

=] FACTORP
Value

=1

Figura 20: Representacion grafica del Factor P
Fuente: Elaboracién propia

3.3.2.6. Obtencion de la erosion hidrica actual y potencial

Para producir el mapa anual de erosiones, se emple6 el Software ArcGis, luego de
haber obtenido los factores R, K, LS, C y P necesarios para la ecuacion RUSLE,
todos ellos con una resolucion de celda de 100 metros, se llevo a cabo el modelado
geoespacial. Para integrar las variables, se utiliz6 la funcion Raster Calculator,
multiplicando los pardmetros obtenidos ArcToolbox > Spatial Analyst Tools >
Map Algebra > Raster Calculator. Mapas de erosion potencial en (Anexo 48 -

70).y mapas de erosion actual en (Anexo 72 - 94).
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Tn/Ha"Ano

I < 5BAJA
I 5 - 25 MODERADA

P [Z125 - 50 MEDIANA
[2150 - 100 ALTA
FACTOR R [ 100 - 200 MUY ALTA
I >200 CRITICA

Figura 21: Uso de ModelBuilder para calcular la Erosién Hidrica Actual_EA (Afio-2000)
Fuente: Elaboracion propia

-l

e
POTENCIAL
= [ EROSION POTENCIAL 2005
Tn/Ha*Afo
FACTORR I <5BAJA
I 5 - 25 MODERADA
[125 - 50 MEDIANA

150 - 100 ALTA
[ 100 - 200 MUY ALTA
I > 200 CRITICA

Figura 22: Uso de ModelBuilder para calcular la Erosién Hidrica Potencial_EP (Afio-2005)
Fuente: Elaboracion propia
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CAPITULO IV

4. RESULTADOS Y DISCUSION

4.1.

RESULTADOS DEL PROCESAMIENTO DE LAS VARIABLES
4.1.1. FACTOR R (EROSIVIDAD DE LA LLUVIA)

Se presenta en la (Tabla 11) la informacién correspondiente al factor de erosividad

de la lluvia para cada estacion y afio de estudio. Se puede observar que el valor

maximo se encuentra en la estacion "V1", con un registro de 24 385,52

Mj*mm/Ha*Hr*Afo en el afio 2001. Por otro lado, el valor minimo se evidencia en

la estacion "Cafaveral”, con un registro de 22,27 Mj*mm/Ha*Hr*Afio en el afio 2022.

Tabla 11: Factor R para cada estacion y por cada afio de analisis.

ARG ESTACIONES
CAMPAMENTO LA CABO <
SEDE CRUZ EL TIGRE INGA CANAVERAL MATAPALO Vi V2

2000 292,27 240,19 858,67 2 360,45 353,73 2 188,90 31313,14 397711
2001 1 660,42 247694 3470,26 5155,87 2 375,66 2 809,15 24 385,52 3745,73
2002 333543 1731,15 3670,06 6211,30 3 295,30 2 025,74 12 254,31 21 198,41
2003 231,43 55,84 553,01 135144 132,70 628,98 1337,01 888,59
2004 226,82 187,47 782,36 1162,72 261,72 878,69 845,09 1041,37
2005 333,25 234,94 873,91  2465,14 128,52 1 003,41 2 775,53 955,40
2006 3 706,68 1864,31 3964,09 465587 1871,13 7 990,93 12 579,33 4 461,76
2007 440,05 709,68 602,81  1967,93 792,88 2721,09 4724,42 1701,49
2008 2690,10 279296 323057 4950,48 2117,86 4 387,26 16 750,39 6 915,39
2009 1 422,66 16259 2054,24 560283 1 890,46 2527,21 7 705,43 11 106,78
2010 1779,07 1112,62 1678,63 594280 1082,47 2 849,35 6 084,53 407255
2011 150,12 446,37 709,48 6 776,67 771,47 1612,07 1266,04 9 061,62
2012 938,60 708,99 223361 7024,80 2 915,76 1 945,61 20 352,54 10870,92
2013 644,53 803,34 123815 2 306,02 1 706,08 4 226,96 570052 1136,38
2014 200,76 100,14 320,84 982,19 153,77 816,44 265,05 228,08
2015 5332,38 229422 3157,04 6486,17 3 255,67 4 879,16 11 824,13 4 244,38
2016 2 362,46 1439,27 3616,92 4 444,00 1 869,38 5189,62 6518,28 6693,13
2017 3 504,59 5063,11 2911,83 781591 1 667,03 4 966,16 7 238,23  9443,35
2018 115,27 197,95 674,30 357,29 112,44 763,05 142,66 266,06
2019 415,21 605,78 187449 3194,10 968,09 3 464,95 4 268,29 2883,75
2020 1 093,76 458,67 1029,32 865,52 327,01 1 395,44 2599,01 1420,74
2021 355,72 285,10 1527,19 152491 915,76 1 695,26 6111,29 189841
2022 407,20 113,15 304,99 1261,73 22,27 1177,93 3604,90 1 468,36

Fuente: Elaboracion propia

La (Figura 23), muestra los valores del factor R promedio por cada afio de estudio,

donde podemos observar que el valor maximo promedio obtenido 7 371,60

Mj*mm/Ha*Hr*Afo para el afio 2002, por otro lado, el valor minimo promedio 362,62

Mj*mm/Ha*Hr*Afo lo encontramos en el afio 2018.
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Figura 23: Factor R promedio para los 23 afios de estudio.

Fuente: Elaboracion propia.

Los resultados sobre el factor R promedio para las 8 estaciones
durante los 23 afios de estudio se encuentra en la (Tabla 12) y la (Figura 24). La
estacion "V1" presenta el valor maximo promedio de 7 063,64 Mj*mm/Ha*Hr*Afo,
mientras que el valor minimo promedio de 1 110,79 Mj*mm/Ha*Hr*Afo se registra
en la estacion "La Cruz". Ademas, se muestra una relacion consistente entre la

precipitacion total anual y el factor R, con un coeficiente de determinacion (R2 =

0,70) como se puede observar en la figura. (Figura 25).

Tabla 12: Valores promedio del Factor R, en las 8 estaciones meteoroldgicas.

meteoroldgicas

ESTACION menm __ MPAMM i)
CAMPAMENTO SEDE 17 305,89 1 375,60
LA CRUZ 6 256,97 1110,79
EL TIGRE 45 479,70 1797,25
CABO INGA 231 835,55 3 689,83
CANAVERAL 133 317,84 1 260,31
MATAPALO 62 700,85 2701,88
Vi 972 806,56 7 063,64
V2 527 884,59 4 768,68

Fuente: Elaboracién propia.
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Figura 24: Factor R promedio por estacion meteoroldgica.
Fuente: Elaboracion propia.
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Figura 25: Relacion entre el factor R y la precipitacion

Fuente: Elaboracion propia
En la (Tabla 13) y la (Figura 26), se muestran los resultados del factor R por area
y porcentaje para la cuenca Tumbes (zona estudiada) con valores de agresividad
de la lluvia de 1 500 a 3 000 Mj*mm/Ha*Hr*Afio que abarca un area de 49,85% (82
919,95 Ha) siendo las zonas con altitud promedio y mayor a 6 000
Mj*mm/Ha*Hr*Afo con una area de 4,49% (7 468,83 Ha) para las zonas con mayor
altitud, con lo que se puede decir que el factor erosividad de la lluvia es un factor

determinante en esta cuenca.
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Tabla 13: Valores del Factor R promedio (2000-2022)

Nro. Rango Clasificacion Area (Ha)  Area (%)
1 < 1500 12 792,54 7,69
3 1500 - 3000 82 919,95 49,85
4 3000 - 4500 Muy Alto 51 184,91 30,77
5 4500 - 6000 11 961,70 7,19
2 > 6000 7 468,83 4,49
Total 166 327,93 100

Fuente: Elaboracion propia

FACTOR R

60.00

49.85%
50.00

40.00
30.77%

Area (%)
w
o
o
o

20.00

0
10.00 7.69% 7.19% 4.49%

0.00 - -

<1500 1500 - 3000 3000 - 4500 4500 -6000 > 6000

Figura 26: Factor R promedio
Fuente: Elaboracion propia

4.1.2. FACTOR K (ERODABILIDAD DEL SUELO)

La (Tabla 14) y (Figura 27), muestra la distribucion de los niveles de Factor K en
el dmbito de estudio, se aprecia que los valores de 0,01521 a 0,01548
Ton*ha*h/Mj*mm*ha son los que predominan con 29,54% (49 138,45 Ha) de los
suelos, por consiguiente, los valores de 0,00140 a 0,01483 Ton*ha*h/Mj*mm*ha
representan el 5,37% (8 929,21 Ha), todos estos valores bajo la clasificacion de

suelos de poca erodabilidad.

Tabla 14: Valores del Factor K representativos de la cuenca Tumbes.

Nro. Rango Clasificacion  Area (Ha) Area (%)
1 0.001406 - 0.01483 8929.21 5.37
2 0.01484 - 0.01520 28358.96 17.05
Muy poco
4 0.01549 - 0.01579 48229.31 29.00
5 0.0158 - 0.01633 31672.02 19.04
Total 166327.93 100.00

Fuente: Elaboracién propia
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Figura 27: Distribucion del factor K
Fuente: Elaboracion propia

La (Tabla 15) y la (Figura 28) presentan la clasificacion textural del suelo y sus
valores de erodabilidad en la cuenca. Se observa la distribucibn geométrica en
hectareas y se destaca que el 43,89% del area total esta compuesto por suelo
Franco Arcillo Arenoso (FAa) con un factor de 0,01560 y en menor proporcion el
24,70% representando un suelo Arcilloso con un factor de 0,01542, todo esto pone

en evidencia la alta erodabilidad de los suelos de textura fina.

Tabla 15: Distribucion del factor K en relacion con las clases texturales.

Nro. Textura Factor K Area(Ha) Area (%)
1 Franco Arcillo Arenoso  0,01560 72 995,86 43,89
2 Franco Arenoso 0,01535 52 254,93 31,42
3 Arcilloso 0,01542 41 077,14 24,70

Total 166 327,93 100,00
Fuente: Elaboracion propia
Relacion de Textura de suelo y Factor K
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Figura 28: Representacion gréfica de la textura de suelo y factor K.
Fuente: Elaboracion propia.
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4.1.3. FACTOR LS (TOPOGRAFIA)

La (Tabla 16) y la (Figura 29) reflejan los resultados del factor LS, donde un 77,91%
(129 585,66 Ha), evidencian valores bajos ubicados en la parte media y baja de la
cuenca, esto debido a que las zonas son llanas, mientras que un 0,01% (10,37 Ha)
presentan valores criticos en la parte alta de la cuenca en relacion a las areas

empinadas que se muestran en esa zona.

Tabla 16: Resultados del Factor LS en la zona de estudio.

Nro. Rango Clasificacion  Area (Ha)  Area (%)
1 <5 BAJO 129 585,66 77,91
2 5-10 MODERADO 32 405,70 19,48
3 10 - 20 MEDIANO 4 265,03 2,56
4 20 -50 ALTO 51,79 0,03
5 50 - 100 MUY ALTO 9,37 0,01
6 >100 CRITICO 10,37 0,01

Fuente: Elaboracion propia
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Figura 29: Representacion gréfica del factor LS
Fuente: Elaboracion propia

Por otra parte, podemos evidenciar en la (Figura 30), la relacion que existe entre
la variable dependiente (pendiente %) siendo explicada por la variable

independiente (Factor LS) con un coeficiente de determinacién de Rz =0,996.
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Figura 30: Relacién entre factor LS y la pendiente

Fuente: Elaboracién propia

4.1.4. FACTOR C (COBERTURA VEGETAL)

Teniendo en cuenta el indice Normalizado de Diferencias de Vegetacion (NDVI),

como se exhibe en la (Tabla 17) y la (Figura 31), se puede evidenciar que para el

rango de estudio la vegetaciéon mediana (VM) es la que se hace mas recurrente con

un valor maximo de 76,95% (127 984,87 Ha) para el afio 2010, por otra parte, para

el aflo 2005 se presento el valor minimo de 43,35% (72 100,60 Ha).

Tabla 17: Valores del NDVI para el afio 2000, 2005, 2010, 2015 y 2020.

Afio 200 Afio 2005
Nro.  Rango Clasificacion Area(Ha) Area (%) Nro.  Rango Clasificacion Area(Ha) Area (%)
1 <0.01 Nuves y Agua (NA) 8618.77 5.18 1 <0.01 Nuvesy Agua (NA) 19177.79 11.53
2 0.01-0.1  SuelossinVegetacion (SV)  10299.22 6.19 2 0.01-0.1  SuelossinVegetacion (SV)  29453.68 17.71
3 01-02 Vegetacion Ligera (VL) 29055.82 17.47 3 0.1-02 Vegetacion Ligera (VL) 40779.62 24.52
4 0.2-04 Vegetacion Mediana (VM)  99422.81 59.78 4 0.2-04 Vegetacion Mediana (VM) 72100.60 43.35
5 >0.4 Vegetacion Alta (VA) 18931.31 11.38 5 >0.4 Vegetacion Alta (VA) 4816.24 2.90
Total 166327.93 100 Total 166327.93 100
Afio 2010 Afio 2015
Nro.  Rango Clasificacion Area(Ha)  Area (%) Nro.  Rango Clasificacion Area(Ha) Area(%)
1 <0.01 Nuvesy Agua (NA) 4503.12 271 1 <0.01 Nuvesy Agua (NA) 2153.72 1.29
2 001-01 SuelossinVegetacion (SV)  2796.26 1.68 2 001-01 SuelossinVegetacion (SV)  2018.75 1.21
3 01-0.2 Vegetacion Ligera (VL) 12469.60 7.50 3 0.1-0.2 Vegetacion Ligera (VL) 23491.21 14.12
4 0.2-0.4  Vegetacion Mediana (VM)  127984.87 76.95 4 0.2-0.4  Vegetacion Mediana (VM)  104619.84 62.90
5 >0.4 Vegetacion Alta (VA) 18574.08 11.17 5 >0.4 Vegetacion Alta (VA) 34044.40 20.47
Total 166327.93 100 Total 166327.93 100
Afio 2020
Nro. Rango Clasificacion Area(Ha) Area (%)

1 <0.01 Nuvesy Agua (NA) 1493.54 0.90

2 0.01-0.1 SuelossinVegetacion(SV)  3022.17 1.82

3 01-0.2 Vegetacion Ligera (VL) 40416.46 24.30

4 0.2-0.4  Vegetacion Mediana (VM)  110177.57 66.24

5 >0.4 Vegetacion Alta (VA) 11218.20 6.74

Total 166327.93 100

Fuente: Elaboracion propia
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Figura 31: Representacion gréfica de los valores de NDVI

Elaboracion propia

En la siguiente (Tabla 18) y la (Figura 32) se revelan los registros que adquiere C
a lo largo del area de investigacion, teniendo como valor maximo 50,08% (83
292,48 Ha) con un valor de Factor C de 0,03149 a 0,03669 presente en el afio 2010,
por otra parte en menor proporcion con 0,79% (1 312,80 Ha) con un valor mayor a
0,04969 evidenciado en el afio 2020, todos estos bajo la clasificacion de alto,
relacionado con el tipo de cobertura (Anexo 13) donde el mayor porcentaje de la
cuenca es ocupada por bosque seco de montafia con un 34,64% del area total en

la parte media y alta, ademas en menor porcentaje 0,011% de estero en la parte

baja de la cuenca.
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Tabla 18: Valores del factor C para el afio 2000, 2005, 2010, 2015 y 2020.

Afo 200 Afio 2005
Nro. Rango Clasificaciéon Area(Ha) Area (%) Nro. Rango Clasificaciéon Area(Ha) Area (%)
1 <0.03149 28468.38 17.12 1 <0.03149 12883.73 7.75
2 0.03149- 0.03669 59130.94 35.55 2 0.03149- 0.03669 37430.72 22.50
3 0.03669- 0.04189 Alto 43233.00 25.99 3 0.03669- 0.04189 Alto 45498.48 27.35
4 0.04189- 0.04969 27488.38 16.53 4 0.04189- 0.04969 52998.42 31.86
5 >0.04969 8007.22 4.81 5 >0.04969 17516.59 10.53
Total 166327.93 100 Total 166327.93 100
Afio 2010 Afio 2015
Nro. Rango Clasificacion Area(Ha) Area (%) Nro. Rango Clasificacion Area(Ha) Area(%)
1 <0.0314% 33661.52 20.24 1 <0.0314% 55771.41 33.53
2 0.03149- 0.0366% 83292.48 50.08 2 0.03149- 0.03669 59415.04 35.72
3 0.03669- 0.0418% Alto 37039.22 22.27 3 0.03669- 0.04189 Alto 38488.80 23.14
4 0.04189- 0.04969 8000.10 4.81 4 0.04189- 0.04969 10605.47 6.38
5 >0.04969 4334.61 2.61 5 >0.04969 2047.20 1.23
Total 166327.93 100 Total 166327.93 100
Afio 2020
Nro. Rango Clasificacion Area(Ha) Area(%)
1 <0.03149 22899.87 13.77
2 0.03149- 0.03669 58274.94 35.04
3 0.03668- 0.0418% Alto 62497.26 37.57
4 0.04189- 0.04969 21343.06 12.83
5 >0.04969 1312.80 0.79
Total 166327.93 100
Fuente: Elaboracion propia
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Figura 32: Representacion gréfica de los valores del Factor C
Fuente: Elaboracion propia




En la (Figura 33), podemos apreciar un coeficiente maximo de determinacion R2
=0,997 para el afio 2010 y un coeficiente minimo de R2 = 0,949 para el afio 2020,
para todos los afios estudiados se les considera que existe una relacion entre la
variable dependiente (NDVI) siendo explicada por la variable independiente (Factor
C).
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Figura 33: Relacion entre el NDVI y el Factor C, para los afios 2000, 2005, 2010, 2015 y 2020.
Fuente: Elaboracion propia

4.1.5. FACTOR P (SUELO)

Como se puso en manifiesto en el item 3.3.2.5 se dio el valor de 1, para no reducir

la precision de la ecuacion.
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4.1.6. EROSION HIDRICA ACTUAL Y POTENCIAL

De las (Tabla 19 y 20) y de las (Figura 34 y 35), se observa la pérdida de suelo
por erosién hidrica actual y potencial, es oportuno aclarar que para este calculo de
la Gltima no se tomo en cuenta el uso factor ¢ ni tampoco el factor p, en este sentido
se aprecia que el nivel maximo promedio de erosién actual y potencial 14.36 y
420.44 Tn/Ha/Afo respectivamente se obtuvieron en el afio 2002 y el valor minimo
de erosion actual y potencial 0.02 y 18.32 Tn/Ha/Afo para el afio 2010 y 2018
respectivamente, cabe resaltar los 4 primeros valores maximos se dieron en el afio

2002, 2008, 2012 y 2017, presentando un escenario critico, debido a las altas

precipitaciones tal es el caso del nifio costero.

Tabla 19: Pérdida de suelo por erosion potencial

Pérdida de suelo por afio del
periodo 2000 - 2022 Tn/Ha*Afo

2000
2001
2002
2003
2004
2005
2006
2007
2008
2009
2010
2011
2012
2013
2014
2015
2016
2017
2018
2019
2020
2021
2022

101,89
301,07
420,44
41,13
41,52
68,31
253,71
84,94
289,16
261,18
180,25
190,63
348,38
102,87
21,91
260,54
223,56
296,51
18,32
124,98
58,96
97,43
57,55

Fuente: Elaboracién propia

71

Tabla 20: Pérdida de suelo por erosién actual

Pérdida de suelo por afio del
periodo 2000 - 2022 Tn/Ha*Afio

2000
2001
2002
2003
2004
2005
2006
2007
2008
2009
2010
2011
2012
2013
2014
2015
2016
2017
2018
2019
2020
2021
2022

3,47
10,00
14,36
1,41
1,43
2,59
0,04
3,20
10,92
9,70
0,02
6,28
11,51
3,44
0,73
8,47
7,18
9,50
0,60
4,02
2,08
3,44
2,01

Fuente: Elaboracién propia
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Figura 34: Erosién Actual promedio para los 23 afios de estudio
Fuente: Elaboracion propia
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Figura 35: Erosion Potencial promedio para los 23 afios de estudio
Fuente: Elaboracion propia

La (Tabla 21) y la (Figura 36), exhiben la erosién hidrica actual y potencial, donde;
los rangos de erosion baja (< 5 Tn/Ha/Afo) alcanza un 58,16% para la erosion
actual (96 738,12 Ha) de forma contraria los niveles de erosion critica (>200
Tn/Ha/ARo) alcanza un 31,92% para la erosién potencial (53 085,80 Ha), si

resaltamos estos resultados con el mapa obtenido, podemos ubicar que la erosién
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baja en mayor porcentaje se da en las zona media y baja de la cuenca, sin embargo
los niveles de erosion critica se desarrollan principalmente en la cabecera de la
cuenca, esto debido a las altas precipitaciones y pendientes que se involucran en
esa zona.

Tabla 21: Niveles de erosion hidrica actual y potencial a nivel de cuenca.

Nro. Rango Clasificacion — Erosion Ac'tual : Erosion Pot?ncial
Area(Ha) Area(%) Area(Ha) Area (%)
1 <5 Baja 96 738,12 58,16 13 487,34 8,11
2 5-25 Moderada 65 919,43 39,63 23 438,46 14,09
3 25-50 Mediana 2 410,35 1,45 20 475,90 12,31
4 50 - 100 Alta 438,03 0,26 25 463,62 15,31
5 100 - 200 Muy alta 412,49 0,25 30 376,80 18,26
6 > 200 Critica 409,51 0,25 53 085,80 31,92
Total 166 327,93 100 166 327,93 100

Fuente: Elaboracion propia

m EROSION POTENCIAE EROSION ACTUAL
70.00
60.00 58.16%
50.00
- 39.63%
X 40.00
8 31.92%
< 30.00
18.26%
20.00 14,05 15.31%
) 12.31%
10.00 8119
I 1.45% 0.26% 0.25% 0.25%
0.00 - — — —
Baja Moderada Mediana Alta Muy alta Critica

Figura 36: Niveles de erosién hidrica actual y potencial a nivel de cunca.
Fuente: Elaboracién propia
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4.2. DISCUSION DE LOS RESULTADOS

Los resultados del factor R en este estudio de la cuenca del rio Tumbes fueron

obtenidos a través de 8 estaciones meteoroldgicas, cuyos valores oscilan entre 1

274,63 a 7 063,55 Mj*mm/Ha*Hr*Afo. ver (Anexo 38), (Moreno, 2017) considera

gue valores mayores a 1000 M) *mm/ Ha* Hr *Afo
donde claramente podemos asumir que la agresividad por las lluvias esta presente

en toda la zona de estudio, haciéndose mas pronunciada en las zonas altas donde

se presentan moédulos pluviométricos anuales (MPA) que llegan a 800 mm ver

(Anexo 11), estando de acuerdo con (Atauje, 2018) donde sefa&idlas que,
zonas de mayor altitud | as amdoesiase puedeci ones
evidenciar que existe una relacion estrecha entre el factor r y la precipitacion

(R2=0,70) ver (Figura 25), tal como lo menciona (Ramirez, 2007) citado por (Atauje,

2018), Afque existe wuna conexi-n <c¢clara &entre
precipitacion anual. Esta relacion se deriva de la definicion misma del indice de

erosividad; de la misma forma (Mendes etal.,,2018)acot an que, fAel ffac
influenciado por la topografia y variacion climéatica regional, con mayor erosividad
asociada a | as .IRarypt@mpate enalledtudia reatizads or (Dioses

& Pérez, 2018) para la cuenca del rio Piura, obtuvieron valores para el factor de

erosividad R de 1 500,67 a 10 582,07 Mj*mm/Ha*Hr*Afo, por lo que se puede inferir

gue estos resultados son similares a los de esta investigacion, ya sea porque

ambas cuencas se encuentran en la region hidrografica del Pacifico, el método

utilizado de Wischmeir y Smith (1978), el uso de los SIG y el registro de

precipitaciones.

Respecto al factor de erosionabilidad K, los valores resultantes oscilan en el rango
de 0,00140 a 0,01633 Ton*ha*h/Mj*mm*ha ver (Anexo 39), segun la clasificacion
USDA (1962), citado por (Amezquita, 1990) toma en cuenta que, para valores
menores a O0.0775 se | a atri bueyreodlaab| ®log s iefsi
resultados concuerdan con los obtenidos por (Camacho et al., 2022) para la cuenca
Cumbaza con valores que oscilan entre 0,0145 a 0,0168 Ton*ha*h/Mj*mm*ha, los
valores mas bajos de erosionabilidad corresponden a suelos de textura arcillo
arenoso y franco arcillo arenoso y los valores medios a suelos de textura franco,
concordando asi con los resultados obtenidos ver (Tabla 15) donde el valor

promedio para los suelos de textura fina (arcilloso) y modernamente fina (franco
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arcillo arenoso) fueron de 0,01542 y 0,01560 Ton*ha*h/Mj*mm*ha respectivamente,
sin embargo para suelos de textura gruesa (franco arenoso) fue de 0,01535
Ton*ha*h/Mj*mm*ha, esto a su vez da a entender que los suelos de textura fina van
a tender a ser mas erosionables debido a que su permeabilidad sera menor por su
contenido de microporos, es decir se produce una mayor escorrentia, lo contrario
sucede en los suelos de textura gruesa, este argumento concuerda con (Castillo &
Rojas, 2019) en su investigacion para la subcuenca Huancay, indicando que la
arcilla es mas resistente al agua, porque la arena posee mayor porosidad, entonces
el agua pude infiltrarse haciendo mas rapido el desprendimiento y transporte de

esta.

La distribucion espacial del factor LS en la zona de estudio generd datos
adimensionales que estan entre 0,030 a 224,91 ver (Anexo 40), presentandose los

valores mas altos precisamente en zonas con mayor longitud y pendiente, esto a

su vez lo explica (Velasquez, 2008) citado por (Valdez, 2014) dejando en manifiesto

gue, f@Amientras mayor sea |l a longitud, mayor
hasta Il egar al punto donde se encuentran
otra parte, segun la clasificacion del instituto espacial ecuatoriano (IEE) citado por

(Moreno, 2017) podemos apreciar (Tabla 16) que mas del 50% se encuentra bajo

|l a clasificacui-do dhke ABMg der,@ite@d 74Ha)bapllaoc el O
clasificaci-n de AMuy Altoo a ACr2ticoo, d
presenta una influencia poco considerada en las zona media y baja de la cuenca

con pendientes de 0 a 70 %. Los resultados de esta investigacion estan dentro del

rango obtenido por (Castillo & Rojas, 2019) con valores de 0 a 854 para la

subcuenca Huancay, de la misma forma (Alvarez, 2019) en su investigacion para

la subcuenca Ichu obtiene valores de 0,03 a 550,7, a su vez ambos concuerdan

gue los valores mas altos se presentan en la cabecera de cuenca, ademas estas

dos investigaciones utilizaron la metodologia planteada por Desmert y Grove (1996)

concluyendo asi que existe una relacion directa entre el factor LS y la pendiente (R2

=0,996) ver (Figura 30) tal como lo menciona(Mancilla, 2008) citado por (Atauje,

2018).

El valor del factor C varia en funcion del tipo de uso y la cubierta vegetal, siendo las
areas boscosas o de plantaciones forestales las que presentan el menor valor. Esto

se debe a que la presencia de estas coberturas vegetales proporciona un mejor
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amortiguamiento de las gotas de lluvia y una mayor capacidad de interceptacion.
Ademas, estas areas cuentan con una distribucion de raices mas efectiva, con
raices mas profundas que proporcionan un mejor soporte para el suelo, tal como lo
menciona (Alvarez, 2019). En ese contexto para nuestra zona de estudio se
obtuvieron valores de NDVI que van de 0,606 a - 0,437 ver (Tabla 17) evidenciando
gue la cubierta de vegetacién mediana es la que se hace presente con un mayor
porcentaje ver (Figura 31) de area, principalmente en la zona alta de la cuenca,
donde se presenta bosque subhimedo de montafia (Bshm) y bosque seco de
montafia (bsm) tal como lo menciona (MINAM, 2015) ver (Anexo 13), por otra parte
se puede apreciar que en los ultimos 5 afios considerados en el estudio se presentd
un aumento de suelos sin vegetacion en un 0,61%, esto sugiere que las areas en
cuestion sufrieron una pérdida significativa de suelo, ya que no contaban con la
proteccion y el amortiguamiento que ofrece la cubierta vegetal, esto es corroborado
por el investigador (Najera et al, 2016) citado por (Castillo & Rojas, 2019) llego a la
conclusiéon de que la presencia de una cubierta vegetal es el factor mas relevante
para disminuir la erosion del agua. Por lo tanto, es imperativo reducir la
deforestacion y fomentar la conservacion de los bosques. Respecto a valores del
factor C se obtuvieron rangos que van de 0,023 a 0,064 con una media de 0,037,
bajo la clasificacion de i A | de acuerdo con el investigador (Taco, 2021), por otro
lado, valores similares se obtuvieron en la investigacion realizada por (Almagro et
al., 2019) con valores que varian de 0,004 a 0,078 con una media de 0,023, donde
al igual que en esta investigacion utilizé la misma metodologia propuesta por
Durigon et al. (2014) y adaptado por Colman (2018), donde podemos inferir que existe
una relacion directa entre el NDVI y el factor ¢ (R2 = 0,949) ver (Figura 33) afirmado
por (Camacho et al., 2022) donde encuentran una relacion altamente significativa entre

los valores de NDVI determinados y los valores del Factor C en la subcuenca Cumbaza.

Através de la estimacion de la pérdida de suelo debido a la erosién hidrica potencial
y actual en la cuenca del rio Tumbes, se pudo identificar las areas con mayor
vulnerabilidad a la erosion. Los resultados mostraron que la erosion potencial (sin
cobertura vegetal) presenta un porcentaje mas alto de erosion critica (31,92%), lo
cual se debe a que este calculo no considerd la influencia de la cobertura vegetal
existente. Ademas, los resultados fueron fuertemente influenciados por la longitud

y el gradiente de pendiente, por lo que se observaron los valores mas altos en las
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zonas con pendientes pronunciadas y en la parte alta de la cuenca. En contraste,
en las zonas de la parte baja de la cuenca con pendientes planas, se evidencié una
menor erosion presente, con un porcentaje mas bajo de erosion de nivel bajo (< 5
Tn/Ha/Afo), representando solo el 8,11%. Se pudo observar la influencia del factor
LS en estos resultados, en lo que coincidimos con (Solano, 2016) ya que en su
estudio estimé que el 47,20% representan una erosion muy alta (> 200 Ton/ha/afio)
generada a partir del 5% en zonas altas, y ademas podemos constatar con
(Perales, 2019) en su estudio para la cuenca del rio Supte Grande obtuvo un
61,67% de erosién muy severa y un 20,80% de erosién potencial de nivel normal
(< 0,5 Tn°/ha/afio). Por otro lado podemos ver que en esta investigacion analizando
cada afio de los 23 en estudio se obtuvieron tasas de erosion que van de 420,44 a
18,32Tn/ha/afio para el afilo 2002 y 2018 respectivamente, representando un
escenario agravante si se llegara a disminuir la vegetacion actual de la cuenca, es
asi que la tasa de erosion potencial promedio fue de 167,18 Tn/Ha/Afio,
concordando este resultado con el obtenido por (Solano, 2016) que fue de 163,13
Tn/Ha/Aio de esta forma inferimos que si no se implementan mediadas de
conservacion de suelos y se sigue deforestando sin control los bosques de la

cuenca, se vislumbra un escenario catastrofico para el futuro de la zona en estudio.

Ahora bien considerando el uso actual de la tierra y cobertura vegetal, es decir la
erosion hidrica actual, se observa que un mayor porcentaje se encuentran niveles
de erosion baja a moderada que representan el 58,16% y 39,63% respectivamente,
particularmente estos valores se establecen en la parte baja y media de la cuenca,
por lo que podemos decir que la cubierta vegetal disminuye el impacto de la gota
de lluvia apaciguando la erosién conjuntamente con las pendientes llanas al
debilitar el recorrido de la misma, sin embargo en zonas sin 0 con poca cobertura
vegetal los niveles de erosién suben a muy alta y critica con 0,25% para ambos,
contrastando lo que se menciona con (Condori, 2021) en su estudio para la cuenca
Cairani, donde menciona que, el 31,35% y el 68,56% toman valores de erosion
hidrica actual leve y moderada, mientras que para la erosion alta y muy alta obtiene
valores de 0,09 a 0,00% respectivamente, es asi que podemos asumir que la
erosion actual o real como también se conoce contrarrestar las superficies con
erosion potencial tal como lo menciona (Solano, 2016). En cuanto a las tasas de

erosion encontradas ver (Tabla 20) podemos observar que la maxima 14,36
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Tn/Ha/Afo y la minima 0,02 Tn/ha/afio para el afio 2002 y 2010 respectivamente,
sobrepasando la tasa méxima permisible en la mayoria de los afios, como lo
menciona (PRODESNOS, 2011 Y Morga R.; 2006) citados por (Quifionez, 2019) Al
destacar que la tasa de erosion hidrica del suelo no deberia superar los 10
Ton/Ha/Afo, ya que este es el ritmo al cual se regenera el suelo, se concluye que
si la tasa de erosién es mayor, no se puede asegurar la conservacion del suelo, ya
que la erosién superaria la generaciéon del mismo, respecto a la tasa de erosion
hidrica encontramos estudios cercanos realizados a la zona de estudio,
especificamente en la vertiente del pacifico, tenemos a (Dioses & Pérez, 2018) en
su estudio para la cuenca Piura donde obtuvieron una tasa de erosién hidrica de
10,4 Tn/Ha/Afo para un periodo de estudio de 35 afios de estudio (1981 1 2016),
por otro lado a una escala mayor tenemos el estudio realizado por (Sabino, 2016)
para las regiones hidrolégicas en el Perl, obteniendo por resultado para la region
hidr ol -cg% fciac oi pad, una t as a ,9dmHakifiopssn tasas
no muy distantes a la obtenida en nuestro estudio, la cual fue de 5,06 Tn/Ha/Afo,
la variacion mas lejana se puede inferir que se da porque nuestro estudio es a nivel

de cuenca a diferencia el de las regiones hidrologicas que es de todo el Pera.
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CAPITULO V

5. CONCLUSIONES

Se estimd la tasa de erosion hidrica en la cuenca del rio Tumbes, aplicando la
metodologia RUSLE con técnicas de teledeteccion, obteniendo asi una tasa de
erosion hidrica potencial (EP) de 167,18 Tn/Ha/Afio dentro de la clasificacion de
amenaza muy alta y una tasa de erosion hidrica actual (EA) de 5,06 Tn/Ha/Afio aun
por debajo de la tasa de erosién hidrica maxima permisible en la clasificacion de

moderada.

Se determinaron los factores que intervienen en el célculo de la erosién hidrica,
encontrandose para el factor de erosividad R valores promedios que van desde 1

274,63 a 7 063,55 Mj*mm/Ha*Hr*Aloc on una <c¢l asi ficaci-n de 0
la zona en estudio, el factor de erodabilidad K que va desde 0,00140 a 0,01633
Ton*ha*h/Mj*mm*hacon wuna cl asificaci-n de Amuy poc
los valores en textura arcillosa, franco arcillo arenoso y franco arenoso, el factor LS

tiene valores que van desde 0,030 a 224,91, encontrandose un area de 77,91%

(129 585,66 Ha) con clasificacion Baja, el factor C con valores desde 0,023 a 0,064

bajo |l a clasificaci-n de AAlItoo para toda
influyentes de bosque subhumedo de montafia y bosque seco de montafia y por

ultimo factor P que se consideré la unidad.

Se determinaron los niveles de erosion hidrica real y potencial aplicando la
metodologia RUSLE con técnicas de teledeteccion en la cuenca del rio Tumbes,
indicando que el 8,11% (13 487,34 Ha) del area en estudio cuenta con erosion
hidrica potencial baja (< 5 Tn/Ha/Afo), el 14,09% (23 438,4 Ha) esta clasificada
como moderada (5 7 25 Tn/Ha/Afo), el 12,31% (20 475,90 Ha) del area de la
superficie considerada como mediana (25 1 50 Tn/Ha/Afo), el 15,31% (25 463,62
Ha) clasificada como Alta (50 i 100 Tn/Ha/Afo), el 18,26% (30 376,80 Ha) del area
considerada como muy alta (100 i 200 Tn/Ha/Afo) y el 31,92% (53 085,80 Ha) del
area en estudio considerada como critica (> 200 Tn/Ha/Afo); respecto a la erosion
hidrica actual o real el 58,16% (96 738,12 Ha) del area en estudio cuenta con
erosion hidrica actual baja (< 5 Tn/Ha/Afo), el 39,63% (65 919,43 Ha) esta
clasificada como moderada (57 25 Tn/Ha/Afo), el 1,45% (2 410,35 Ha) del area de
la superficie considerada como mediana (251 50 Tn/Ha/Afo), el 0,26% (438,03 Ha)
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clasificada como Alta (50 i 100 Tn/Ha/Afo), y el 0,25% (412,49 Ha) del area
considerada como muy alta (100 i 200 Tn/Ha/Afo) y critica (> 200 Tn/Ha/AfR0)
respectivamente, todo aquello bajo la clasificacion de la FAO.

Se identificaron las zonas que presentan mayor riesgo de sufrir erosion hidrica,
siendo aquellas en las que se combinan varios factores con valores elevados, ya
sea en zonas con pendientes pronunciadas, poca vegetacion, suelos de baja
calidad, elevadas precipitaciones y falta de medidas de conservacion de suelo.
Estas areas se localizan en las laderas y cimas de las montafias de la parte media
y alta de la cuenca, especificamente en los distritos de San Jacinto, Pampas de
Hospital y Matapalo alcanzando en su mayoria niveles de erosion mediana, alta,

muy alta y critica ver (Anexo 71y 94).
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CAPITULO VI

6. RECOMENDACIONES

Es importante enfocarse en las areas mas erosionadas a corto plazo,
especialmente en las partes altas de la cuenca que son mas propensas a perder
suelo y que presentan altas tasas de erosion, es por ello que se deben priorizar
estas zonas para abordar la problematica de la erosion.

Para reducir el factor LS y mitigar la erosion, se recomienda la construccién de
zanjas de infiltracién junto con la implementacién de una cobertura vegetal que se
cologue en contra de la pendiente. Esta medida tiene como objetivo disminuir la
velocidad del agua de escorrentia, retener la humedad y asi reducir su capacidad

de causar erosion.

La presencia de cobertura vegetal es crucial para reducir la erosion en una region,
por lo que se sugiere implementar programas de reforestacion en las partes altas
de la cuenca como estrategia de conservacion. De esta manera, se protegeria el
suelo contra la erosion mediante el enraizamiento y la caida de hojas de las plantas,

lo que también mejoraria la capacidad de infiltracion del suelo.

Se recomienda realizar medidas de conservacion y/o recuperaciones propuestas
en las zonas donde se encontrd erosion moderada a critica, con los surcos de
contorno, terrazas de absorcion y control de la escorrentia, la implementacion de
estas técnicas contribuira a mejorar las caracteristicas de la textura del suelo,
disminuir la pendiente, incrementar la capacidad de infiltracion e incrementar la
cantidad de materia organica. Esto no solo beneficiara al suelo, si no también tendra
un impacto positivo en la produccion, asi mismo, el mapa de erosién hidrica
potencial y actual de la cuenca del rio Tumbes deber ser tomado en cuenta como
una herramienta técnica para la planificacion territorial. De esta manera, se podria
evitar la implementacion de practicas agresivas en los territorios mas sensibles,

asegurando una utilizacion sostenible de los recursos naturales.
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CAPITULO VI
8. ANEXOS

Anexo 1: Registro de precipitacion acumulada mensual 7 anual en mm, pre tratamiento estadistico.

Estacion meteorolégica Campamento Sede: precipitacion acumulada mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: CAMPAMENTO SEDE LATITUD: 3°33'4.14" S DPTO. TUMBES

N° DE REGISTROS: 23 ANOS LONGITUD: 80°25'46.64" W PROV. TUMBES

PERIODO: 2000-2022 ALTITUD: 17 m.s.n.m DIST. TUMBES
ANO ENE. FEB. MAR. ABR. MAY. JUN. JUL. AGO. SET. OCT. NOV. DIC. TOTAL
2000 10.30 36.40 64.20 66.40 26.00 1.80 0.20 1.50 0.70 0.00 0.00 3.70 211.20
2001 33.00 70.30 194.60 56.80 1.00 0.40 1.30 0.00 0.70 0.10 2.40 0.70 361.30
2002 1.60 211.90 292.80 99.50 0.10 0.80 0.00 0.80 1.30 2.30 0.50 5.70 617.30
2003 22.90 28.00 12.10 6.50 3.10 0.90 3.10 0.50 0.00 0.00 0.00 60.80 137.90
2004 9.40 23.60 31.00 59.20 5.70 0.70 0.80 0.00 0.90 3.30 0.00 1.80 136.40
2005 4.60 5.10 59.30 19.20 0.00 0.00 0.00 0.30 0.00 0.40 0.00 6.50 95.40
2006 33.60 267.20 56.60 8.40 1.10 0.00 0.90 1.40 0.00 1.20 1.50 10.60 382.50
2007 70.70 4.00 58.10 4.00 3.00 0.20 0.40 1.10 0.00 0.30 3.50 2.40 147.70
2008 128.70 | 270.50 105.90 25.50 0.60 2.00 0.20 0.00 0.80 0.10 0.07 0.00 534.37
2009 117.50 | 168.70 27.30 20.50 5.50 1.40 0.00 0.80 1.00 0.00 3.20 3.00 348.90
2010 17.80 187.40 180.80 94.90 1.20 1.40 0.20 0.00 0.00 0.00 2.40 2.00 488.10
2011 21.80 43.90 3.80 38.50 13.30 0.00 7.50 0.00 0.00 0.00 0.20 1.00 130.00
2012 80.10 155.00 95.10 74.80 3.00 0.00 0.40 0.00 0.00 2.90 1.90 1.50 414.70
2013 15.30 43.90 105.10 26.00 2.20 1.60 1.00 0.00 0.00 4.70 0.00 0.00 199.80
2014 42.36 29.70 1.90 4.60 53.00 7.90 0.00 0.00 0.00 5.00 0.00 3.70 148.16
2015 11.40 38.00 330.60 25.40 39.40 1.30 0.00 0.00 0.30 6.50 1.20 3.00 457.10
2016 27.10 241.00 174.40 70.00 0.10 2.00 0.00 0.80 1.30 0.00 0.00 6.30 523.00
2017 143.90 90.90 337.40 58.60 35.00 0.20 0.00 0.30 0.90 2.90 0.10 0.70 670.90
2018 12.80 30.00 8.80 0.30 33.40 0.00 0.00 0.20 0.00 0.30 1.20 34.20 121.20
2019 66.30 87.70 34.30 17.80 0.30 0.30 0.20 0.90 0.00 1.10 0.40 23.20 232.50
2020 34.30 141.60 63.20 7.60 0.50 0.90 1.90 0.20 0.40 0.00 1.00 5.20 256.80
2021 65.70 12.80 76.10 12.90 13.40 2.40 1.10 0.90 0.10 6.30 3.70 10.70 206.10
2022 61.30 18.10 85.90 25.00 12.40 4.50 0.90 1.10 0.10 4.00 0.50 0.30 214.10
PROMEDIO 44.9 95.9 104.3 35.8 11.0 1.3 0.9 0.5 0.4 1.8 1.0 8.1 305.9
MAXIMO 143.9 270.5 337.4 99.5 53.0 7.9 7.5 15 1.3 6.5 3.7 60.8 670.9
MINIMO 1.6 4.0 1.9 0.3 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 95.4
DESVIACION 40.79 89.15 101.21 30.25 15.37 1.78 1.63 0.50 0.46 2.20 1.24 14.01 174.62

Fuente: PEBPT
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Estacion meteorolégica La Cruz: precipitacion acumulada mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: LA CRUZ LATITUD: 3°37'41.85" S DPTO. TUMBES

N° DE REGISTROS: 23 ANOS LONGITUD: 80°34'9.36" W PROV. TUMBES

PERIODO: 2000-2022 ALTITUD: 6 msnm DIST. LA CRUZ
ANO ENE. FEB. MAR. ABR. | MAY. JUN. JUL. AGO. SET. OCT. NOV. DIC. TOTAL
2000 14.70 | 38.40 51.80 | 54.40 | 58.10 | 1.90 0.10 0.90 0.70 0.00 0.00 1.80 | 222.80
2001 2470 | 35.20 | 215.50 | 37.30 | 5.20 0.00 0.90 0.80 0.80 0.00 2.80 2.20 | 325.40
2002 4.70 | 159.60 | 187.10 | 79.40 | 0.70 0.00 0.00 0.00 0.60 1.60 0.30 5.90 | 439.90
2003 25.30 | 22.40 13.90 | 13.70 | 0.70 0.70 2.20 0.30 0.70 0.00 0.40 |15.60 | 95.90
2004 13.20 | 50.60 16.40 | 38.80 | 9.80 0.10 0.90 0.00 0.60 0.10 0.00 0.50 | 131.00
2005 9.90 8.60 49.00 2.20 | 0.30 0.70 0.00 0.10 0.00 2.30 4.70 3.30 81.10
2006 21.10 | 186.80 | 117.20 | 2.90 | 0.00 0.00 1.30 0.60 0.10 0.00 3.80 6.30 | 340.10
2007 54.90 0.60 98.80 9.00 | 2.20 0.00 0.10 1.70 0.00 1.60 3.10 1.70 | 173.70
2008 116.00| 271.50 | 117.10 | 13.60 | 0.60 0.60 0.10 0.00 1.50 0.10 0.90 0.00 | 522.00
2009 87.60 | 168.60 | 12.60 8.10 | 2.80 0.00 0.00 0.20 2.50 0.20 2.00 1.20 | 285.80
2010 10.00 | 123.10 | 143.80 | 90.10 | 0.60 1.80 0.20 0.00 0.00 0.20 1.40 1.50 | 372.70
2011 5.20 72.70 2.30 37.40 | 1.10 0.20 3.50 1.70 0.00 0.10 0.70 0.60 | 125.50
2012 34.90 | 127.90 | 79.50 | 56.90 | 11.60 | 5.80 0.00 0.10 0.10 1.00 1.50 0.60 | 319.90
2013 19.40 | 40.40 | 114.40 | 13.60 | 2.60 2.20 0.90 0.00 0.10 1.90 0.00 3.80 | 199.30
2014 37.70 | 17.10 6.80 4.40 | 29.40 | 7.40 0.40 0.50 0.60 5.60 0.00 4.30 | 114.20
2015 3.90 37.40 | 215.20 | 55.60 | 21.20 | 0.00 1.30 0.20 0.00 8.20 1.30 0.00 | 344.30
2016 1745 | 95.90 | 175.71 | 52.43 | 0.02 1.88 0.34 0.13 0.33 0.06 0.00 2.23 | 346.49
2017 121.30| 77.40 | 405.00 | 85.40 | 34.50 | 1.00 0.10 0.80 0.50 1.20 0.70 1.00 | 728.90
2018 12.10 | 45.50 1.00 0.20 | 16.50 | 0.00 0.30 0.20 0.00 0.30 0.40 |43.00 | 119.50
2019 18.60 | 103.40 | 25.80 | 39.90 | 0.00 0.00 0.00 1.10 0.00 2.10 0.30 8.90 | 200.10
2020 11.60 | 82.10 62.30 0.20 0.00 0.10 | 14.20 | 170.50
2021 30.10 | 12.90 67.20 | 40.90 | 6.40 0.10 0.00 0.10 0.00 1.20 1.00 0.10 | 160.00
2022 7.70 17.50 35.80 | 11.70 | 0.20 0.00 0.00 0.10 1.10 2.00 0.50 0.50 77.10
PROMEDIO 30.5 78.1 96.3 34.0 9.3 11 0.6 0.4 0.5 13 11 5.2 256.4
MAXIMO 121.3 | 271.5 405.0 90.1 | 58.1 7.4 3.5 1.7 2.5 8.2 4.7 43.0 728.9

MINIMO 3.9 0.6 1.0 0.2 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 77.1

DESVIACION | 33.50 | 68.58 96.03 | 28.25 | 14.75 | 1.94 0.88 0.52 0.62 1.98 1.32 9.28 | 160.26

Fuente: SENAMHI
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Estacion meteorolégica El Tigre: precipitacion acumulada mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: EL TIGRE LATITUD: 3°48'8.4" S DPTO. TUMBES
N° DE REGISTROS: 23 ANOS LONGITUD: 80°27'24" W PROV. TUMBES
PERIODO: 2000-2022 ALTITUD: 45 msnm DIST. SAN JACINTO
ANO ENE. FEB. MAR. ABR. MAY. JUN. JUL. AGO. SET. OCT. NOV. DIC. TOTAL
2000 3.20 |111.80 | 134.00 | 112.90 | 101.40 | 6.00 0.30 0.00 0.60 0.00 0.00 9.90 | 480.10
2001 63.20 | 53.30 | 300.70 | 68.90 | 11.90 1.20 0.00 0.00 0.00 0.00 4.00 8.10 | 511.30
2002 7.80 ]198.30 | 338.30 | 213.60 | 3.30 0.00 0.00 0.00 0.80 0.60 0.00 | 23.20 | 785.90
2003 96.90 | 81.80 | 37.20 | 10.50 0.40 2.50 3.20 1.00 0.80 0.00 0.00 | 14.80 | 249.10
2004 10.90 | 124.10 | 53.30 | 72.50 5.60 0.00 2.20 0.00 1.00 1.50 0.40 0.70 | 272.20
2005 1.10 | 17.40 | 102.90 | 17.90 0.20 0.00 0.00 0.90 0.00 1.90 3.10 3.10 | 148.50
2006 53.50 | 306.50 | 112.10 | 5.00 0.70 1.30 1.50 1.50 2.40 0.70 4.00 5.50 | 494.70
2007 94.55 | 8.50 90.90 | 43.40 1.20 0.00 1.40 0.80 1.10 1.00 5.10 4.20 | 252.15
2008 138.20 | 328.70 | 181.10 | 58.00 | 12.70 2.90 0.70 0.50 1.30 2.70 2.60 0.00 | 729.40
2009 191.52 | 200.30 | 89.00 5.80 2.30 0.80 0.20 1.60 1.50 0.80 0.80 0.80 | 495.42
2010 94.70 | 178.10 | 218.10 | 121.80 | 5.10 5.00 2.70 0.30 0.90 0.30 1.10 6.60 | 634.70
2011 45.70 | 64.00 3.40 |114.80| 0.40 1.40 1.30 0.10 0.60 0.40 1.20 9.80 | 243.10
2012 135.90 | 280.50 | 190.30 | 112.30 | 24.80 | 10.70 0.40 0.30 0.10 2.00 4.40 3.50 | 765.20
2013 28.30 | 54.42 | 150.90 | 8.70 6.20 0.80 1.30 1.00 0.30 5.80 0.10 2.60 | 260.42
2014 85.50 | 54.82 | 12.10 7.20 51.00 | 22.10 1.70 2.00 1.20 6.10 1.10 | 15.80 | 260.62
2015 25.70 | 114.70 | 344.40 | 180.60 | 109.40 | 3.80 4.00 0.70 0.00 7.40 4.00 3.80 | 798.50
2016 33.00 | 327.30 | 247.70 | 129.30 | 0.60 6.80 0.00 0.60 0.00 0.40 0.60 |11.00 | 757.30
2017 144.90 | 276.30 | 326.80 | 249.71 | 111.40 | 3.50 0.70 2.40 1.20 3.10 0.00 0.30 | 1120.31
2018 34.10 | 113.60 | 4.40 0.50 24.70 0.00 0.30 0.50 0.50 0.30 0.80 | 65.50 | 245.20
2019 108.60 | 212.30 | 229.60 | 108.80 | 3.10 0.50 1.20 1.40 0.00 0.90 3.50 [32.30| 702.20
2020 13.80 | 118.50 | 140.60 0.00 0.00 0.30 0.50 |17.50 | 291.20
2021 67.20 | 37.30 | 192.30 | 44.10 | 13.90 1.50 0.10 0.70 0.20 4.80 2.10 5.50 | 369.70
2022 13.30 | 12.10 | 64.00 | 18.60 2.20 3.50 0.90 0.60 0.00 1.30 0.10 1.60 | 118.20
PROMEDIO 64.9 | 142.4 | 155.0 77.5 22.4 3.4 11 0.7 0.6 1.8 17 10.7 477.6
MAXIMO 191.5 | 328.7 | 344.4 | 249.7 | 1114 22.1 4.0 2.4 2.4 7.4 5.1 65.5 | 1120.3
MINIMO 11 8.5 3.4 0.5 0.2 0.0 0.0 0.0 0.0 0.0 0.0 0.0 118.2
DESVIACION | 53.36 | 105.24 | 107.44 | 71.90 | 36.57 4.98 1.11 0.67 0.63 2.17 1.71 | 14.40 | 264.98

Fuente: PEBPT
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Estacion meteorolégica Cabo Inga: precipitaciéon acumulada mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: CABO INGA LATITUD: 3°58'33.39" S DPTO. |TUMBES
N° DE REGISTROS: 23 ANOS LONGITUD: 80°24'6.54" W PROV. |TUMBES
PERIODO: 2000-2022 ALTITUD: 231 m.s.n.m DIST. SAN JACINTO
ANO ENE. FEB. MAR. ABR. MAY. JUN. JUL. AGO. SET. OCT. NOV. DIC. TOTAL
2000 6.60 | 177.90 | 274.30 | 183.60 | 83.90 6.00 0.00 0.00 0.00 0.00 0.80 6.60 | 739.70
2001 253.80 | 207.00 | 470.20 | 154.20 | 8.80 0.00 0.00 0.00 0.00 0.00 6.30 | 10.50 | 1110.80
2002 5.40 | 359.90 | 444.40 | 427.80 | 6.20 1.00 0.00 0.00 0.00 | 26.50 0.00 | 73.20 | 1344.40
2003 112.30 | 183.90 | 126.00 | 25.20 4.20 5.30 0.00 0.00 0.00 0.00 3.50 | 11.90 | 472.30
2004 28.40 | 151.40 | 119.40 | 34.00 5.30 4.00 0.00 0.00 0.00 4.70 0.00 0.00 | 347.20
2005 13.40 | 15.70 | 210.80 | 37.40 0.00 12.50 0.00 0.00 0.00 0.00 5.60 |16.10 | 311.50
2006 87.50 | 404.90 | 233.00 | 57.20 | 25.90 0.30 0.60 0.00 0.00 0.00 8.60 | 29.40 | 847.40
2007 94.60 | 33.80 | 227.20 | 93.40 0.40 0.30 0.00 0.00 0.00 0.00 0.00 8.40 | 458.10
2008 185.50 | 456.20 | 300.50 | 115.10 | 42.60 1.30 20.90 0.00 0.00 1.90 1.40 0.00 | 1125.40
2009 465.60 | 364.90 | 274.90 | 71.10 | 19.10 0.00 0.00 0.00 0.00 0.00 1.10 | 45.70 | 1242.40
2010 171.10 | 320.90 | 495.60 | 110.20 | 35.70 9.10 0.50 0.00 0.00 0.30 2.90 3.10 | 1149.40
2011 24,10 | 54.80 | 23.00 | 421.20 | 41.70 | 40.50 6.40 0.00 0.00 4.70 2.80 |13.50 | 632.70
2012 184.90 | 570.00 | 444.70 | 382.90 | 76.80 2.20 5.50 0.00 0.00 0.80 4.00 6.20 | 1678.00
2013 44.50 | 67.20 | 243.30 | 36.60 | 44.10 0.00 0.00 0.00 0.00 4.20 0.00 2.40 | 442.30
2014 63.10 | 77.50 | 53.00 | 27.30 | 175.60 | 23.80 0.30 0.00 0.20 6.80 2.90 9.80 | 440.30
2015 59.40 | 103.90 | 464.60 | 469.20 | 72.30 | 85.80 9.20 0.00 0.60 1.70 10.00 | 0.00 | 1276.70
2016 71.34 | 381.91 | 322.81 | 198.92 | 0.49 12.61 0.26 0.10 0.22 0.66 0.00 9.05 | 998.40
2017 312.60 | 369.20 | 493.40 1.40 1.90 1178.50
2018 71.60 | 83.50 | 19.20 | 24.10 | 80.70 0.00 0.00 0.00 0.00 0.00 37.50 | 69.80 | 386.40
2019 79.50 | 312.80 | 307.80 | 87.50 | 26.80 4.60 0.00 0.70 0.10 0.00 0.40 | 98.70 | 918.90
2020 49.80 | 99.50 | 158.10 | 27.60 | 33.20 4.90 3.40 0.00 0.00 0.10 0.40 | 44.00 | 421.00
2021 110.50 | 65.30 | 225.90 | 131.10 | 48.40 4.40 0.50 0.40 0.10 0.80 0.40 | 10.30 | 598.10
2022 38.10 | 24.40 | 171.90 | 52.20 2.00 1.60 2.20 0.70 0.00 0.10 0.30 | 40.40 | 333.90
PROMEDIO | 110.2 | 2125 | 265.4 | 144.0 37.9 10.0 2.3 0.1 0.1 2.4 4.0 23.1 802.3
MAXIMO 465.6 | 570.0 | 495.6 | 469.2 | 175.6 85.8 20.9 14 1.9 26.5 37.5 98.7 | 1678.0
MINIMO 54 15.7 19.2 24.1 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 311.5
DESVIACION |110.93| 162.81 | 149.29 | 145.52 | 41.42 | 19.42 4.87 0.35 0.41 5.73 8.02 | 27.48 | 401.32

Fuente: SENAMHI

89



Estacion meteorolégica Cafiaveral: precipitacion acumulada mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: CANAVERAL LATITUD: 3°56'20.75" DPTO. TUMBES
N° DE REGISTROS: 23 ANOS LONGITUD: 80°39'2.1" W PROV. C.M.V.Z

PERIODO: 2000 - 2022 ALTITUD: 133 m.s.n.m DIST. CASITAS
ANO ENE. FEB. MAR. ABR. MAY. | JUN. JUL. AGO. SET. OCT. NOV. DIC. TOTAL
2000 1.14 74.73 61.05 | 100.44 | 26.22 | 3.52 | 0.00 0.00 0.00 0.00 0.00 5.53 | 272.63
2001 115.57 | 104.09 | 335.28 | 72.90 1.53 | 0.00 | 0.00 0.00 0.00 0.00 2.08 2.72 | 634.16
2002 12.47 | 184.98 | 410.33 | 240.20 | 1.68 | 0.00 | 0.00 1.18 0.51 0.48 0.01 1.83 | 853.68
2003 22.62 | 56.64 14.15 42.29 0.66 | 0.19 | 0.05 0.00 0.00 0.00 0.01 |12.54 | 149.13
2004 3.22 78.22 37.93 23.55 1.81 | 0.00 | 0.07 0.00 0.00 5.00 0.00 0.00 | 149.80
2005 2.11 9.36 48.07 12.23 0.01 | 0.03 | 0.00 0.00 0.00 0.00 0.20 2.01 74.02
2006 29.04 | 23547 | 61.36 4.79 0.03 | 1.19 | 0.06 0.00 0.00 0.00 0.35 1.89 | 334.18
2007 61.96 3.50 143.66 | 19.56 0.02 | 0.00 | 0.00 0.00 0.00 0.00 0.08 0.24 | 229.03
2008 124.74 | 301.04 | 126.37 8.18 051 | 0.11 | 0.92 0.00 0.00 2.22 0.08 0.00 | 564.17
2009 230.86 | 122.97 | 103.60 | 38.54 | 3.28 | 3.58 | 0.00 0.00 0.00 0.00 6.35 5.03 | 514.20
2010 46.46 | 134.79 | 147.78 | 75.20 0.17 | 0.04 | 0.59 0.00 0.00 0.01 0.02 2.71 | 407.78
2011 7.88 62.81 0.11 105.69 | 0.16 | 0.02 | 11.38 0.00 0.00 0.02 0.10 4.01 | 192.18
2012 71.17 | 213.37 | 296.68 | 94.05 | 16.64 | 0.26 | 0.03 0.00 0.00 0.02 0.77 0.11 | 693.10
2013 22,23 | 34.53 | 159.69 5.65 6.27 | 0.00 | 0.01 0.00 0.00 1.01 0.00 0.13 | 229.52
2014 14.90 | 43.99 7.36 4.98 25.36 | 0.46 | 0.03 0.00 0.00 1.58 0.00 0.24 98.90
2015 7.16 44.49 | 290.36 | 119.42 | 37.54 | 3.44 | 0.08 0.00 0.00 0.34 0.62 9.73 | 513.18
2016 21.42 | 124.27 | 217.36 | 106.05 | 0.04 | 2.56 | 0.00 0.16 0.00 0.00 0.00 1.43 | 473.30
2017 137.70 | 214.2 65.00 | 121.20 | 0.00 | 0.00 | 0.00 0.00 0.00 0.00 0.00 0.30 | 324.20
2018 9.40 6.10 18.70 1.70 19.50 | 0.00 | 0.00 0.00 0.00 0.00 42.60 | 20.70 | 118.70
2019 21.30 | 157.10 | 109.20 | 56.40 4.40 | 0.60 0.20 0.00 0.00 0.20 | 59.40 | 408.80
2020 58.80 | 38.30 68.30 4.50 0.20 | 1.00 | 0.10 0.00 0.00 0.20 0.00 | 15.60 | 187.00
2021 9.40 1.10 110.20 | 35.10 7.80 | 230 | 0.10 0.10 0.20 0.10 0.10 1.10 | 167.60
2022 4.30 6.10 11.90 11.00 140 | 0.20 | 0.10 0.10 0.00 0.10 0.00 [11.90| 47.10
PROMEDIO 45.0 92.6 123.7 56.7 6.9 1.0 0.6 0.1 0.0 0.5 2.3 6.9 332.0
MAXIMO 230.9 | 301.0 410.3 240.2 37.5 4.4 11.4 1.2 0.5 5.0 42.6 59.4 853.7

MINIMO 11 11 0.1 1.7 0.0 0.0 0.0 0.0 0.0 0.0 0.0 0.0 47.1

DESVIACION | 57.41 | 83.63 | 114.46 | 58.05 | 10.88 | 1.47 | 2.36 0.25 0.11 1.14 8.88 | 12.78 | 218.66

Fuente: SENAMHI
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Estacion meteoroldgica Matapalo: precipitacion acumulada mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: MATAPALO LATITUD: 3°40'57.94" S DPTO. TUMBES

N° DE REGISTROS: 23 ANOS LONGITUD: 80°11'54.64" W PROV. ZARUMILLA

PERIODO: 2000-2022 ALTITUD: 62 m.s.n.m DIST. MATAPALO
ANO ENE. FEB. MAR. ABR. MAY. JUN. JUL. AGO. SET. OCT. NOV. DIC. TOTAL
2000 14.10 | 104.50 | 279.90 | 94.60 | 154.60 | 6.20 2.40 3.50 2.80 0.40 0.10 | 27.30 | 690.40
2001 81.30 | 121.10 | 298.90 | 64.30 | 13.10 | 2.80 2.20 0.30 0.40 2.70 8.40 | 12.20 | 607.70
2002 61.50 | 233.80 | 246.20 | 152.90 | 7.30 0.20 0.60 3.60 3.20 14.00 2.50 | 74.70 | 800.50
2003 101.40| 121.60 | 36.80 | 23.50 7.40 4.70 5.40 1.70 3.50 1.60 3.60 | 55.90 | 367.10
2004 72.60 | 148.50 | 122.70 | 89.00 9.00 3.50 3.10 2.00 3.10 3.90 3.00 8.60 | 469.00
2005 27.30 | 47.20 | 143.90 | 29.90 1.80 3.70 0.60 1.40 1.70 5.40 1.50 7.60 | 272.00
2006 67.00 | 496.60 | 154.10 | 14.10 2.50 6.60 2.90 3.00 3.20 1.10 17.40 | 34.20 | 802.70
2007 227.70| 18.80 | 244.60 | 58.60 | 14.60 | 1.70 2.60 2.10 1.30 2.40 3.50 5.00 | 582.90

2008 269.00 | 409.70 | 229.60 | 75.30 7.90 |15.60| 3.50 2.20 1.80 6.30 7.30 0.70 | 1028.90
2009 270.30 | 229.40 | 117.60 | 29.60 | 16.20 | 2.10 | 0.90 3.40 5.50 1.50 9.00 | 27.70 | 713.20

2010 187.60 | 207.50 | 303.10 | 289.00 | 19.20 | 8.30 | 3.30 1.50 2.10 4.40 3.30 | 21.40 | 1050.70
2011 41.00 | 202.40 | 21.90 | 11490 | 6.20 7.30 | 4.90 2.40 1.60 3.40 5.50 | 15.30 | 426.80
2012 253.70 | 224.20 | 94.30 | 187.00 | 55.40 | 25.60 | 3.50 2.10 1.50 8.00 7.60 | 14.10 | 877.00
2013 115.80| 97.10 | 356.10 | 21.00 | 12.90 | 3.30 2.60 2.70 0.80 12.60 0.70 |14.50 | 640.10
2014 158.11| 99.90 | 1490 | 20.10 | 96.60 | 50.60 | 3.60 2.60 2.60 9.80 3.00 |19.50 | 481.31
2015 76.40 | 119.60 | 463.70 | 107.20 | 211.50 | 4.40 | 9.00 2.70 2.40 11.70 8.40 | 14.89 | 1031.89
2016 85.80 | 442.89 | 285.65 | 152.14 | 1.73 5.13 1.51 0.99 1.82 0.88 2.66 | 19.63 | 1000.83
2017 200.40 | 347.90 | 465.20 2.60 2.00 1018.10
2018 153.00 | 31.50 7.40 71.60 | 0.20 2.00 19.10 | 1540 | 4.20 14.70 | 91.10 | 410.20
2019 132.80 | 373.20 | 166.90 | 89.20 5.20 0.70 1.10 1.40 1.10 2.80 14.60 | 62.60 | 851.60
2020 19.60 | 181.20 | 186.00 | 104.90 | 17.10 | 6.70 | 8.50 0.80 1.90 1.10 7.30 | 47.60 | 582.70
2021 141.90| 108.20 | 236.30 | 62.80 | 17.80 | 6.00 | 4.90 2.90 0.80 9.60 3.10 | 11.10 | 605.40
2022 158.90| 63.10 | 147.60 | 39.00 6.10 5.20 | 12.20 1.10 0.60 1.80 0.50 2.90 | 439.00

PROMEDIO | 125.7 | 197.9 | 202.1 83.0 34.4 7.8 3.7 2.9 2.7 5.0 5.8 26.8 684.8
MAXIMO 270.3 | 496.6 | 465.2 | 289.0 | 211.5 | 50.6 12.2 19.1 154 14.0 17.4 91.1 | 1050.7
MINIMO 14.1 18.8 14.9 7.4 1.7 0.2 0.6 0.3 0.4 0.4 0.1 0.7 272.0

DESVIACION | 80.99 | 131.86 | 127.71 | 67.62 | 54.49 | 11.06 | 2.91 3.65 3.00 4.16 4.82 | 24.55 | 240.58

Fuente: SENAMHI
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Estacion Virtual V1: precipitacion acumulada mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: VIRTUAL 01 LATITUD: 4°8'40.96" S DPTO. TUMBES

N° DE REGISTROS: 23 ANOS LONGITUD: 80°34'12.21" W PROV. C.M.V.Z

PERIODO: 2000-2022 ALTITUD: 17 m.s.n.m DIST. CASITAS
ANO ENE. FEB. MAR. ABR. MAY. | JUN. JUL. AGO. SET. OCT. NOV. DIC. TOTAL
2000 9.13 | 298.35 | 244.93 | 196.65 | 28.31 | 3.74 | 0.00 0.24 0.00 0.50 0.00 | 13.74 | 795.58
2001 149.60 | 157.84 | 975.92 | 157.90 | 3.04 | 0.09 | 0.15 0.33 0.00 0.64 2.67 5.60 | 1453.78
2002 10.95 | 421.71 | 734.38 | 427.15 | 2.26 | 0.01 | 0.04 0.73 0.23 2.82 0.30 5.71 | 1606.29
2003 67.31 | 164.57 | 28.83 22.35 1.05 | 1.20 | 0.07 0.30 0.07 0.38 0.31 | 12.03 | 298.46
2004 19.88 | 126.45 | 85.12 32.73 3.51 | 0.00 | 0.11 0.20 0.06 5.00 0.08 1.87 | 275.01
2005 6.46 30.43 | 198.71 | 11.06 0.20 | 0.37 | 0.00 0.27 0.01 1.16 0.54 5.86 | 255.06
2006 57.44 | 619.84 | 24255 | 11.72 0.21 | 0.31 | 0.22 0.29 0.00 0.54 2.05 5.75 | 940.92
2007 98.38 | 14.03 | 317.39 | 30.10 1.10 | 0.03 | 0.00 0.25 0.04 1.07 0.32 2.19 | 464.89
2008 229.42 | 871.91 | 458.84 | 65.37 437 | 1.16 | 0.67 0.31 0.01 3.35 0.66 0.40 | 1636.46
2009 511.20 | 387.73 | 429.23 | 26.79 1.28 | 0.45 | 0.00 0.27 0.06 0.59 2.58 6.52 | 1366.70
2010 61.75 | 428.16 | 343.07 | 86.60 264 | 013 | 0.23 0.29 0.00 1.77 0.24 3.45 | 928.34
2011 20.55 | 93.79 6.11 150.76 | 0.94 | 0.52 | 3.47 0.28 0.00 1.30 0.96 7.40 | 286.10
2012 108.84 | 983.18 | 596.10 | 190.83 | 11.90 | 0.50 | 0.16 0.27 0.06 1.30 1.78 2.24 |1897.15
2013 4477 | 5595 | 35149 | 19.19 | 17.13 | 0.00 | 0.00 0.31 0.00 3.78 0.00 2.47 | 495.08
2014 34.84 | 72.59 30.86 9.81 2659 | 221 | 0.15 0.32 0.08 4.65 0.00 5.53 | 187.64
2015 23.96 | 90.52 | 603.69 | 131.72 | 36.84 | 1.51 | 0.22 0.25 0.00 3.03 1.61 9.25 | 902.59
2016 66.85 | 391.89 | 447.63 | 121.84 | 0.86 | 3.54 | 0.05 0.39 0.09 0.76 0.00 5.20 | 1039.11
2017
2018
2019
2020
2021
2022

PROMEDIO 89.5 306.4 358.5 99.6 8.4 0.9 0.3 0.3 0.0 1.9 0.8 5.6 644.8
MAXIMO 511.2 | 983.2 975.9 427.2 36.8 3.7 3.5 0.7 0.2 5.0 2.7 13.7 | 1897.2
MINIMO 6.5 14.0 6.1 9.8 0.2 0.0 0.0 0.2 0.0 0.4 0.0 0.4 187.64
DESVIACION |123.16 | 291.93 | 265.86 | 107.41 | 11.64 | 1.19 | 0.83 0.11 0.06 1.53 0.94 3.57 | 616.45

Fuente: SENAMHI
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Estacidn Virtual V2: precipitacion acumulada mensual - anual, enero de 2000 a diciembre de 2022.

ESTACION: VIRTUAL 02 LATITUD: 3°54'56.08" S DPTO. TUMBES

N° DE REGISTROS: 23 ANOS LONGITUD: 80°14'26.12" W PROV. ZARUMILLA

PERIODO: 2000-2022 ALTITUD: 527 m.s.n.m DIST. PAPAYAL
ANO ENE. FEB. MAR. ABR. MAY. | JUN. JUL. AGO. SET. OCT. NOV. DIC. TOTAL
2000 24.39 | 199.32 | 220.47 | 387.83 | 4791 | 9.31 | 0.05 0.44 0.59 1.34 2.07 | 25.34 | 919.05
2001 193.43| 93.33 | 331.38 | 340.96 | 9.68 | 1.18 | 0.53 0.47 0.58 1.96 20.66 | 19.20 | 1013.35
2002 13.38 | 327.91 | 333.84 | 993.96 | 4.56 | 0.97 | 0.28 0.55 0.31 9.81 4.37 | 32.31 | 1722.25
2003 137.07 | 136.73 | 32.56 61.96 2.64 | 453 | 0.52 0.47 0.54 2.36 3.30 | 47.01 | 429.68
2004 56.10 | 103.54 | 48.86 | 166.51 | 8.30 | 0.65 | 041 0.35 0.85 12.30 3.55 8.76 | 410.19
2005 11.26 | 20.74 | 137.42 | 41.85 0.99 | 1.98 | 0.00 0.42 0.14 3.78 7.52 | 28.63 | 254.72

2006 140.52 | 398.62 | 180.12 | 52.43 | 0.76 | 1.91 | 0.63 0.57 0.31 1.88 18.62 | 17.58 | 813.95

2007 196.55| 13.33 | 171.26 | 122.63 | 3.21 | 0.84 | 0.07 0.68 0.20 4.93 5.28 | 11.42 | 530.40

2008 259.04 | 586.81 | 279.94 | 304.50 | 10.17 | 3.06 | 0.95 0.65 0.37 7.99 8.04 2.40 |1463.93

2009 676.15| 247.00 | 172.26 | 8546 | 457 | 097 | 0.14 0.64 0.35 1.75 9.28 | 22.57 | 1221.15

2010 152.33 | 303.11 | 186.92 | 396.49 | 6.15 | 1.71 | 0.43 0.47 0.64 5.88 6.56 | 16.87 | 1077.53

2011 61.86 | 96.57 5.03 486.70 | 3.03 | 243 | 2.04 0.30 0.39 4.35 8.98 | 27.01 | 698.71
2012 241.95| 532.55 | 306.76 | 752.09 | 20.13 | 2.84 | 0.30 0.31 0.06 4.59 13.36 | 10.74 | 1885.67
2013 84.16 | 68.36 | 188.96 | 80.73 | 20.90 | 0.89 | 0.23 0.55 0.35 19.13 2.66 9.00 | 475.92
2014 70.29 | 67.34 19.16 31.54 | 42.00 | 10.50 | 0.43 0.48 0.52 16.36 3.73 | 33.98 | 296.34
2015 55.76 | 98.61 | 363.32 | 337.85 | 47.06 | 4.40 | 0.56 0.36 0.27 10.19 | 18.08 | 22.59 | 959.03
2016 148.00 | 383.95 | 188.04 | 530.20 | 1.63 | 10.21 | 0.24 0.41 0.97 2.35 2.83 | 20.07 | 1288.92
2017
2018
2019
2020
2021
2022
PROMEDIO | 148.4 | 216.3 186.3 304.3 13.8 3.4 0.5 0.5 0.4 6.5 8.2 20.9 672.2
MAXIMO 676.2 | 586.8 363.3 994.0 | 47.9 | 105 2.0 0.7 1.0 19.1 20.7 47.0 | 1885.7
MINIMO 11.3 13.3 5.0 315 0.8 0.7 0.0 0.3 0.1 1.3 2.1 2.4 | 254.72

DESVIACION |156.38 | 177.79 | 113.13 | 273.14 | 16.35 | 3.35 | 0.47 0.12 0.24 5.37 6.02 | 11.07 | 585.47

Fuente: SENAMHI
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lisis estadistico (saltos y tendencias).

On pre ana

7z

Anexo 2: Hidrogramas de los registros de precipitaci

HIDROGRAMA PRECIPITACION ESTACION "CAMPAMENTO SEDE"

Precipitaciones mensuales acumuladas (mm)
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HIDROGRAMA PRECIPITACION ESTACION "LA CRUZ"
Precipitaciones mensuales acumuladas (mm)
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HIDROGRAMA PRECIPITACION ESTACION "EL TIGRE"

Precipitacion acumulada mensual (mm)
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HIDROGRAMA PRECIPITACION ESTACION "CABO INGA"

Precipitaciones mensuales acumuladas (mm)
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HIDROGRAMA PRECIPITACION ESTACION "CANAVERAL"

Precipitacion acumulada mensual (mm)
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